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Introduction

Chapter 1 introduces Base using a simple flat database. Then chapter 2 discusses the planning 
and designing stages of database creation. This is a very important part of the Base Guide 
because poor planning and designing result in a poor database. Appendix A contains the planning 
and designing of the relational database mentioned in chapter. This serves as an example of the 
principles contained in this chapter.

This chapter, Data input and removal, builds upon the plan and design created in Chapter 2. Here 
we use the plan and design to create the tables and forms.

Chapter 4, Data output, also builds upon the plan and design of Chapter 2. We discuss how to 
create the queries and reports for the database.

Chapter 5 discusses how Writer, Calc, Impress and Base can be used together.  In some cases, 
two or three of these components may be used at one time to accomplish a task.

Later chapters address more advanced uses of Base. This includes customization of Base and 
using Base in a work environment.

Included in this chapter, chapter 4, we introduce a different type of database with which Base can 
connect. It is a little faster and less prone to loose data under a variety of circumstances.

Create the database

After chapter 2, you have your plan and design for the database. It is time to use them to create it. 
But remember that plans are not always perfect. So changes may have to be made to improve it.

Create the database file
How you do this depends upon the circumstances. One method that works regardless of whether 
you are at the splash screen or have opened any of the components of LibreOffice (Writer, Calc, 
Impress or Base). Another method works when any of the components are open. And finally, the 
splash screen has another.

Use this method when you are at the splash screen or have a component open.

• Select File > New > Database

When you have one of the components open, use this one

• Click the New icon's arrow (red circle) and select Database from the menu.

Figure 1: Opening Base using the New 
Icon

When the splash screen is open, use this one.

• Click the Database icon or use Alt+A.
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Figure 2: Opening Base using the splash screen

When any of these methods are used, the Database Wizard opens with 2 steps listed on the left. 
The first step is selected by default. Here you have three choices:

• Create a new database.

• Open an existing database file

• Connect to an existing database.

Figure 3: Database Wizard window

What you select in this step determines what appears next. Creating a new database has a 
second step, opening an existing database file closes the wizard, and connecting to an existing 
database will have additional steps depending upon what type of database is accessed.

Step 2 of the Database Wizard opens.

• Click Finish to register the database and open the database for editing, leaving the default 
selections as they are.

The Save window opens:
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• Replace New Database in the Name box with the name of your new database (to follow 
the learning example, create one now and name it Budget).

• Verify the the file type is listed as ODF Database in the bottom right corner.

• Browse to the location where you want to save the new database file.

• Click Save.

Once you have created a new database and saved it, the main database window opens. Opening a 
database file will open this same window. It contains three sections: Database, Tasks, and List section. 
The latter's name matches the name of the database object selected in the Database section. Click 
another in the Database section, and the name in the List section changes.  Below is a screen shot of a 
Database File Window when a new database is first created.
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Tip

The first time a database is opened, the Tables database object is highlighted in the 
Database section. Every time thereafter the Forms database object is selected. The 
reason for this is that the first thing you should do with a database is create one or 
more tables. But after the initial steps of creating the tables, queries, forms, and 
reports, you are most likely to open the database to enter or remove data from a 
form.

The Database section allows you to select which part of the database to use. This chapter uses 
the Tables icon to work with the tables or the Forms icon to work with the forms. Later chapters 
demonstrate the uses of the Queries and Reports icons.

The Task section shows the tasks available to the user based on which icon was selected in the 
Database section. In Figure 5, the Tables object is selected, so the Tasks sections shows the two 
ways to create a table and one way to create a view. Had we clicked the Forms icon, three tasks 
would have appeared. Click the Queries icon, and three tasks appears. Click the Reports icon, 
and two task appears.

The right side of the Tasks section is labeled Description. Move your cursor over any of the tasks 
listed to see a description of it.

The List section will vary in content depending upon which icon is selected in the Database 
section.   Click the Tables icon to see a list of all your tables. Click the Queries, Forms, or Reports 
icons to see a list of all your queries, forms, or reports respectively.

In the right-hand side of the List section is an drop down menu offering three choices None, Document 
information, and Document. None is the Default setting, and nothing appears below this menu. If 
Document information is selected, the window contains information about the selected form or report. 
(When Tables or Queries are selected in the Database section,  Document information is not an available 
option.) If Document is selected a thumbnail appears of the selected, table, query, form or report. (The 
thumbnail will only show part of the table, query, form, or report if there is not room to show it all.)

Tip
Viewing a Document thumbnail requires you to make two selections: a document 
object in the Database section, and an item in the List section.

Figure 4: Document information for a selected Form
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Figure 5: A table's Document thumbnail

Create the tables
As discussed in previous chapters, databases are made up of one or more tables.   Have your 
database design ready with the list of fields and field types you will need for each of  your tables. 
You already have the database open. If not, open the database in which you want to create a 
table.

There are two ways to create a table: using the Table Wizard, or using Design View. Chapter 1 of 
the Base Guide, Introducing Base, describes how to use the Table Wizard. So if you are going to 
use this method for creating the entire table, follow the instructions in Chapter 1.

In this chapter we describe how to use the wizard for a special situation: creating part of a table 
whose primary key contains two or more fields. This is a task that the wizard can do, but the Table 
Design dialog can not.

If you do not need to create a multiple field primary key for a table, go to the next section: Create a 
table in design view.

Using the Table Wizard
When a table's design requires a multiple field primary key, use the Table Wizard to create the 
fields of the primary key. Then edit the table to add the rest of the fields.

8 Chapter 3 Data Input and Removal



Figure 6:

The sample tables is a drop down list. Any of these tables will serve our purpose, so we will use 
the default table, Assets.

1) Click Use Wizard to Create Table.

2) Click AssetID and then click the right arrow to move it into the Selected fields list.

3) Click Next.

Figure 7: Step 2 of the Table Wizard
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The next step is to remove the AssetID field and add the primary key fields.

1) At the bottom of the Selected fields list, there are two buttons: a + and a – . Click the – to 
delete AssetID.

2) Create the fields:

a) Click the + button. Field appears in the Selected fields list and the Field name box.

b) Replace Field in the Field name box with the name of the first field for the primary 
key, Primary key 1.

c) You will selecting the Field types and properties later, so ignore them for now.

d) Repeat steps a) and b) for each field in the primary key.

3) Click Next.

4) Set the primary key:

a) Select Define primary key as a combination of several fields.

b) Click each field and then the right arrow to move all the fields to the Primary key list.

c) Use the up or down arrow to change the order of the fields if necessary.

5) Click Next.

6) Create table:
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a) Enter the name of your table as the name you want to use (I used new Table as an 
example.)

b) Select Modify the table design.

7) Click Finish. (The Table Design dialog opens.)

Tip
When the dialog opens, you will see a key to the left of each one of the fields for 
your primary key. This key identifies that the field belongs to the primary key.

Follow the instructions of the following section to modify the primary key fields and to add the rest 
of the fields for the table. The only difference between modifying a field and adding one is that the 
field has already been given a name, a Field Type, and Field Properties. Changing any of these 
values is basically doing the same thing as selecting them for a new field.

Create a table in design view
The Table Design dialog has three labeled columns at the top: Field Name, Field Type, and 
Description. Below them is the Field Properties section. To the left of the Field Name column is the 
column where the primary key is designated by one or more key icons. In the snapshot above, the 
primary key consists of three fields. In many cases, a table's primary key will contain only one 
field. After you select a field to be the table's primary key, this key will in front of this field.

The Field Name column is where you enter the field names, and the Field Type column contains 
drop down lists for each field where you will be selecting what you listed in the database design. 
The Description is for any notes for yourself or for others. Finally, The Field Properties give you 
more choices as to each field's properties.

Figure 8: Top of the Table Design dialog

To create a new table using Design View, you need to have the database open to the main 
database window. In the Database section, the Tables object should be selected. Now you have 
three choices in the Tasks section: two choices of how to create a table, and one choice of how to 
create a view.

• Click Create Table in Design view. (The Table Design dialog opens.)
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Tip

A table can be opened for editing (to add fields, remove fields, or change field 
properties). To do so:

1) Click the Tables icon in the Database file Window,
2)  Click the name of your table in the Tables section, and choose Edit > Edit in the 

menu bar and the table will reopen in the Table Design dialog.
3) Or, right click the table's name, and select Edit from the context menu. The table 

also opens in the Table Design dialog.

Name your fields
Creating a table involves a series of steps: naming a field, selecting its Field Type, entering a 
description of it, and selecting its properties. You go through these steps for each field of the table. 
Next to last you define what field will be the primary key. Finally, you name and save the table.

Each one of these steps will be discussed in its own section and in sequence. I have also used a 
link in the last section that will bring you back to this section. This way you can follow the steps for 
a field from beginning to end, click on the link, and return to here so you can follow them for the 
next field if necessary.

Use Field Name column to create a field, modify a field name, or delete a field.

• To create a field:

1) Click the top cell that is empty.

2) Enter the name of the field to be created.

• To modify a field name, edit it.

• To delete a field, right click the gray rectangle before the field's name. Select Delete from 
the context menu.

Setting the Field Type for each field
The field you correct or modify will have one of 21 field types. (See Table 1) By the time you 
finished the design of your tables, you wrote down the name of the fields and each of their field 
types. Now you will select the correct field type for each field of the table you are creating.

Each cell of the Field Type column contains a drop down list with the 21 field types, and selection 
of a specific field type is done the same as is done using any drop down list.

• Double click the cell where you want to select a Field Type to open the drop down list.

• Click the file type to select it.

Tip

You can move from one cell to the next by using Enter or Tab. The use of either  
moves your cursor from Field Name to Field Type, to Description with successive 
uses of one of them. Use of either in the Description will move the cursor to the 
Field Name in the next row.

Adding a Description
This allows you to make notes about the fields of the table that might refresh your memory 
sometime in the future. For example, You could identify the table for which the field is a foreign 
key. Or, you could use abbreviations for the field's name and enter the full name here. Also, you 
could state what purpose the field serves.

• Click the Description cell.

• Enter anything in this cell that will provide information that you or someone else might 
need.
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Setting Field Properties in the Table
These permit you to further define a field's characteristics beyond its field type. The Field 
Properties have a section of their own at the bottom of the Table Design dialog. What is contained 
in this section depends upon what is first selected as the field type. The following table will contain 
the properties available for each field type.

Table 1: Field Types and their Field Properties

Field Type Field Properties

Tiny Integer Entry required, Length, Default Value, Format example

BigInt AutoValue, Entry required, Length, Default Value, Format example

Image Entry required, Length, Default Value

Binary Entry required, Length, Format example

Binary (fix) Entry required, Length, Format example

Memo Entry required, Length, Default Value, Format example

Text (fix) Entry required, Length, Default Value, Format example

Number Entry required, Length,Decimal places, Default Value, Format example

Decimal Entry required, Length,Decimal places, Default Value, Format example

Integer AutoValue, Entry required, Length, Default Value, Format example

Small Integer Entry required, Length, Default Value, Format example

Float Entry required, Length,Decimal places, Default Value, Format example

Real Entry required, Length,Decimal places, Default Value, Format example

Double Entry required, Length,Decimal places, Default Value, Format example

Text Entry required, Length, Default Value, Format example

Text (ignore case ) Entry required, Length, Default Value, Format example

Yes/No Entry required, Length, Default Value

Date Entry required, Default Value, Format example

Time Entry required, Default Value, Format example

Date/Time Entry required, Default Value, Format example

OTHER Entry required, Default Value, Format example

AutoValue appears as a field property for the field types, BIGINT and INTEGER. Set this property 
to YES for only three conditions: the field is the table's primary key, the field type is one of these 
two types, and you want Base to auto-generate the values for this field.

Entry Required tells Base whether every row of the table must have an entry for this field or not. 
(This selection should have been made for every field in the design stage.)

Length defines how many characters or digits are permitted in an entry. But if you look at the 
Range column in the table below, you see that this is approximate. Tiny Integer has a length of 3 
digits, but -999 to -129 and 128 to 999 are not accepted as entries. For this you should use Small 
Integer.

 In the case of binary fields, it defines how long the data block can be.
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Decimal places determines how many digits are permitted to the right of the decimal place. (LO 
calls this a decimal separator.) This combines with Length for numerical values. The maximum 
number of digits permitted to the left of the decimal place the Length value minus the Decimal 
places. For example, a Length of 5 and 2 decimal places limits the number of digits to the left of 
the decimal place to 3. (5-2=3).

Default Value: use this if you want to have a specific value present for the field until you change it.

Format example allows you select a rather specific format for field entries. For example, date 
formats, currency formats, and textual formats can be defined here. However, this formatting will 
only be seen when viewing the table. If the table will be contained in a form, formatting will have to 
be applied to the field in the form as well.

Caution

1) Be careful that your entries and selections match what is in your database plan and 
design. Each of the available properties for a field determine the characteristics of 
the field. Use the wrong value can create frustration. Entry required can prevent you 
from adding additional data to your table.

2) Length when not being long enough will limit the number of characters you can 
enter. When the field type is numerical if nature, exceeding the range of the 
selected field type will cause incorrect data to be entered into to the field. Take 
Small Integer for example which has a digit length of 5. But entering a number 
greater than 32,767  will change your entry to either a positive or negative integer or 
0 depending upon the integer you enter. (32768 becomes -32768; -32769 becomes 
32767; 65536 or -65536 both become 0.) Make sure your likely entries will lie 
within the range of the field type you have chosen to use.

Each row of the table in the dialog has information about a specific field. The left cell is its name, 
the center cell is its field type, and the right cell is its description. Each row also determines what 
appears in the Field Properties section, the properties that belong to the field of that row. Select 
the Field Name, Field Type, or Description cell of a row, you also select the Fields properties of 
that row.

Table 2: Fields Types and their default lengths

Field Type name Field Type Length Range

Tiny Integer [TINYINT] 3 -128 to 127 (signed)
0 to 255

BigInt [BIGINT] 19 -9,223,372,036,854,775,808 
to

9,223,372,036,854,775,807

Image [LONGVARBINARY] 2147483647 2147483647

Binary [VARBINARY] 2147483647 2147483647

Binary (fix) [BINARY] 2147483647 2147483647

Memo [LONGVARCHAR] 2147483647 2147483647

Text (fix) [CHAR] 100 1 TO 8000

Number [NUMBER] 100 -1038 to 1038

Decimal [DECIMAL] 100 -1038 to 1038

Integer [INTEGER] 10 -2,147,483,648 to 
2,147,483,647

Small Integer [SMALLINT] 5 -32,768 to 32,767

14 Chapter 3 Data Input and Removal



Field Type name Field Type Length Range

Float [FLOAT] 17 -1038 to 1038

Real [REAL] 17 -1038 to 1038

Double [DOUBLE] 17 -1038 to 1038

Text [VARCHAR] 100 1 TO 8000

Text  
[VARCHAR_IGNORE
CASE]

100 1 TO 8000

Yes/No [BOOLEAN] 1 N/A

Date [DATE N/A N/A

Time [TIME] N/A N/A

Date/Time [TIMESTAMP] N/A N/A

OTHER OTHER 2147483647 2147483647

1) Double check as to which row contains the cursor. This is the field whose field properties 
you are selecting. The cursor should still be in the Field Type or Description cell of the field 
you have named and given its field type. If it is not there, click the Description cell for that 
field.

2) Carefully select each of the field properties that matches what you wrote for the database 
plan and design.

3) Check your settings in the Field Properties section once again to be sure you have the 
correct entries.

If you understand how to create the rest of the fields in the table, do so. Then you will be ready to 
define what field will be the table's primary key. Or, you can use this link Name your fields to help 
you create the rest of the fields one at a time.

Tip
When you click to make a change to a Field Property, helpful notes appear at the 
right side of the window to describe what the chosen available properties do.

Setting a Primary Key
The Table Design dialog will create a primary key with only one field of the table. To create a 
primary key with multiple fields you must use the Table Wizard. A SQL statement can be used to 
do this as well, but the amount of space required to describe this is beyond the level of the present 
Base Guide.

Using the Table Design dialog
You begin by selecting the field you want to use as the table's primary key. Then you change the 
Field Properties of this field. But you may have already done most of this when you created the 
fields for the table.

1) Right click the gray box to the left of the field name that you want to define as the primary 
key.

2) Select  Primary Key in the context menu menu that appears.
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Tip
Base allows only one field to have the AutoValue Field Property set to Yes. Once a 
field has been named and given this field property, Base sets this field as the 
Primary Key as soon as you move the cursor from this field's row to another row.

Saving the table
1) Click the Save icon.

2) Enter the table name in the Save AS dialog.

3) Click OK

4) Close the table.

If you have more tables and their fields to create do so now. If you have a View or perhaps more, 
you can create them following the instructions in the Query section. (A View if very similar to a 
query.) The next part for creating a database is the Form.

Create the form
This is done using the Form Wizard, Database Form dialog (Design View), or a combination of the 
two. The wizard offers you choices, and creates a form based upon what you select. The dialog 
provides you with a Writer document with several toolbars with which you can create all the form.

But before going any farther, you need to review the plan and design for the form. If it contains 
only one object (query, table, or view), your only concern is whether you use the dialog or wizard 
to create the form. But if you have two or more objects, You have to consider the relationships 
between the objects to be included in the form.

If the form has two tables with a primary-foreign key pair, it will have a main form and subform. 
The table with the primary key of this pair belongs in the main form, and the table with the foreign 
key belongs in the subform. And if there is another primary-foreign key pair, the form is further 
divided into a form and its subform. The wizard can create one main form and subform. For 
anything more complex, the wizard may be able to begin the form's creation, but the dialog will 
have to be used to finish it.

In most cases, use the wizard for the basics and the dialog to modify the form as needed to meet 
the design requirements. What part of the creation will be done by each part? It depends upon the 
complexity. The wizard is for the simpler part, and the dialog is for the more complex. For 
example, the wizard can only create a form with one relationship between 2 tables. The dialog can 
create a form with multiple relationships between tables.

Form Wizard
In most cases, the layout of a form created by the wizard needs some modifications. It has created 
the basics for the form which saves some time. It provides 4 choices for the layout of each control 
in the form. The dialog has one layout for this: the rest you have to create yourself.

Whether you use the wizard or not is your choice. Some prefer to use the wizard as much as 
possible, and others prefer to use the dialog exclusively.

Note

Forms are used to display, input, or remove data. The last two will be for tables only. 
Data can be displayed for queries, table and views. In fact, a form can display data 
from a combination of a combination of these three. It just requires the form to be 
properly planned and designed.

There are 2 ways to open the Form Wizard.

1) Select the database object (query, table, or view) for the form.
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a) In the Main Database window, click the Table or Query object in the Database section 
depending upon what is to be in the form.

b) Right click the object you want to use.

c) Select Form Wizard from the context menu.

2) Use the Task section of the Main Database window.

a) Click the Form object in it.

b) Select: Use Wizard to Create Form.

Figure 9: 8 steps of Form Wizard

Tip
 In the first page of the wizard, you will select the query, table, or view to be uses 
along with the specific fields. In the first method, right clicking the specific object 
selects it for page 1. Then you only have to select the fields for the form.

 Step 1: Field selection

If you had right clicked a query, table, or view to select Form Wizard from the context menu, the 
Tables and queries list will already have the selection you want to use. (Figure 10) Otherwise, you 
have to open this drop down list to select the one you want to use.

• If your form contains only one table, select it from the Tables or queries list.

• If your form contains two tables that have a primary-foreign key pair, select the table that 
has the primary key.

Caution When you place two tables with a primary-foreign key pair, one will be in the main 
form, and the other in the subform. The one containing the primary key of this pair 
must be in the main form. The one containing the foreign key must be in the 
subform. Otherwise only part of the data will be displayed.

The Available fields list contains the names of the fields of the selected object. From this list you 
select the fields you will use in the form.

The database plan and design should contain what fields should be selected. As a review of why a 
field might not be needed, I have included the next two paragraphs.

In most cases, all of the available fields will be used in the form, but not always. If there is a 
primary key, it might not be used especially if it is part of a primary-foreign pair. Also look at Tools 
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> Relationship. If you have defined the relationship here and this pair has INTEGER as their field 
type, you do not need to use the primary key. The relationship you defined is applied by Base to 
the applicable tables and queries.

If you use a JOIN to define relationships in the queries instead of Tools > Relationship, you need 
to use all of the fields to make them available in Step 4 to define the relationship between the main 
form and subform. Figure 11 is an example of doing this. If I had defined the relationship using  
Tools > Relationships, Transactions ID would not be present in the Fields in the form list.

There are four types of arrows with which you can move the fields between the Available fields to 
the Fields in the form lists: single right arrow, double right arrow (default), single left arrow, and 
double left arrow. The single arrows move selected fields in the arrow's direction; the double 
arrows move all the fields.

Figure 10: Fields and their source

• If all the fields are included, click the double right arrow to move them to the Fields in the 
form list.

• Moving some of the fields:

• Click one of the fields follow by clicking the right single arrow. Do this for each field 
you want to move, one field at a time.

• OR, Shift+click all the fields to be moved to highlight them. Then click right single 
arrow.

Tip
If you move more fields than what you should, you can move the field back to the 
Available fields list by using highlighting the field and using the single left arrow. 
(You could use the double left arrow to move all the fields.)

You may decide that you want to change the order of the fields that appear in the form. This is the 
purpose for the up and down arrows.
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Figure 11: Form fields and their order

• To move a field higher in the list, click the field and then click the up arrow.

• To move a field lower in the list, click the field and then click the down arrow.

Step 2: Set up a subform

You only use this step if you have two tables with a primary-foreign key pair. Otherwise, you click 
Next to go to the next step.

You have chosen the table with the primary key and the fields to be used from it. For the subform, 
you will select the table with the foreign key (see the above caution).

When you have defined the relationship between the tables using  Tools > Relationships, the 
wizard places the name of the second table in the box, Which relation do you want to add.

1)

2) Check the option button Subform based on existing relation.

3) Click the name of the table for the subform (Data in this example).

4) Click NEXT.

Figure 12: subform using Tools > Relationships

When you use a JOIN (INNER, OUTER LEFT, OUTER RIGHT), you only need to add the 
subform. Because the default option button is Subform based on manual selection of fields, you 
will have to select the fields to use in the JOIN in step 4.

1) Check Add Subform.

2)
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Figure 13: subform using JOIN

Step 3: Add subform fields

If you are using Tools > Relationships, the wizard displays the table name you selected for the 
subform and the list of its available fields. If you are using a JOIN, you will have to select the table 
containing the foreign key from one of the tables in the Tables or queries list.

Again your selection of the fields depends upon you are using a JOIN or not. If you are using it, 
you have to include the foreign key and the table's primary key. If you are not using a JOIN, these 
two are not required. The other choice which was made in the plan and design determines what 
field you add to the subform.

1) Proceed as you did in step 1 when you selected the fields for the main form.

2) Click NEXT.

Your selection in step 2 determines whether you go to step 4 or step 5. If you selected the option 
button,  Subform based on manual selection of field, you go to step 4.

Step 4: Get joined fields

This steps defines the primary-foreign key pair. In the simplest pair, there are 2 fields, one in each 
table. In more complex pairs, both the primary and foreign key consists of at least two fields in 
each key. This is the reason for having more than one line of matching the fields in the foreign key 
with their corresponding fields in the primary key.

Figure 14: Selecting the primary-foreign key pair

1) Select the first field of the foreign key from the First joined subform field dropdown list.

2) Select the corresponding field from the First joined main form field dropdown list.

3) Select the rest of the fields of the foreign key and their corresponding primary key fields.

4) Click NEXT.
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Step 5: Arrange controls

Control
A database object containing two parts: the label and field. The former can be the name of the 
associate field (default) or you can edit it. The latter is used to enter data into the field.

Figure 15: Layout of controls

The label placement choices are only available for the first arrangement choice, Columnar – 
Labels on Top. For the rest of the choices, the label is aligned left. (All field entries are aligned 
left.)

The controls of the form (and its subform) can have one of four layouts: columnar – labels left, 
columnar – labels on top, as data sheet, or in blocks – labels on top. The difference between 
columnar and in blocks is the order of the controls is the former arrange the controls by column. 
while the latter arrange the controls by rows. In columnar, the controls are placed in columns 
beginning with the top left. Each column is filled in from the top to bottom rows before going to the 
top row of the column to the right. In blocks also begins at the top left. The difference being that 
the rows are filled in from left to right columns from the top row and going down the rest of the 
rows.

When the form wizard opens, a new Writer document opens as well to show you what effects your 
selections have on the form. This really does not matter very much until now. Because the default 
layout is As Data, you first see two tables with the labels as the headings for each. Make another 
selection to change it.

1) Select the arrangement for the main form. Also select the label placement alignment if you 
have selected Columnar – Label Left.

2) Select the arrangement for the subform (if you have one). Also select the label placement 
alignment if you have selected Columnar – Label Left.

3) Click NEXT.

Step 6: Set data entry
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Figure 16: What data can be seen, added, modified, or 
deleted

This step has two options: displaying only new data or displaying all data. These are explanatory: 
selecting the top option will allow to only see the data you are entering. Selecting the bottom 
option will allow you to see all of the data.

Most often the form displays all data. Yet there are likely reasons for the form being used to enter 
new data only.

Three check boxes determine what you can do with the data. These too are somewhat 
explanatory. Once you have entered and saved data, you can not make any changes if you check 
the top box. Check the middle box, and you can not delete data that has been saved. Check the 
bottom box, and you will only be able to see previously entered data.

What check boxes you select depends upon the purpose of the form? For example, a database 
form that is available to the public might need all three boxes checked. This would prevent the 
public from modifying, deleting, and adding data.

• Select whether the form displays all data or it displays only data as it is being entered and 
saved.

• Select what check boxes should be checked to match your limitations on data entry when 
using the form.

Tip
The default settings are shown in Figure 16. They are also the most used 
selections.

Step 7: Apply styles

Figure 17: Control border and Form background
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The Apply styles list contains some of the colors in the color palate included with LibreOffice. What 
you are selecting is a background color. (Beige is the color Orange 4.)

The Filed border comes in three choices. If you move the form wizard so that you can see some of 
the controls, you will see the different borders as you change your selection.

1) Select the background color for the form from the Apply styles list.

2) Select the field border you want to use.

3) Click NEXT.

Step 8: Set Name

Figure 18: Naming form and next step

The wizard will suggest a name based upon the table, query, or view it contains. This form 
contains the table, Transactions. Accept the suggested name or change it.

This is the last step, so you have to tell the wizard what you want to do next. When you click 
Finish, the wizard closes and the default setting opens the form ready to receive data entry. Or, if 
you want to do some editing of the form, select Modify the form. Clicking Finish closes the wizard 
and opens the Database Form dialog.

1) Make sure the form name is what you want it to be. Make any changes necessary.

2) Select one of the option buttons depending upon what you want to do next.

a) Work with form to open the it ready to enter data.

b) Or, Modify the form to edit the form.

3) Click Finish to close the wizard and open either the form or the Database Form dialog.

I recommend that you select modifying the form. This includes changing the size of the controls,  
their positions, their properties, the background, and some of them from visible to invisible. Text 
can be add to label the form and some of its parts.

The next section discusses how to create a form from scratch You can use these instructions to 
modify a form also.

Design View
This is a much more labor intensive method for creating a form. It requires paying very close 
attention to the details of the database plan and design. The form wizard created the form based 
upon the information you gave it. Now you have to do all of this yourself.

There is a common statement “starting over with a clean sheet.” You will be starting with a new 
sheet (form) literally. It is a new Writer document with a visible grid.
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When you create a form using Design View, you need to organize how you will proceed. Once you 
have opened the form in Design View, save the form. After that you are ready to create it.

Use of the Form Navigator dialog comes first because you need it to create the main form plus 
any subforms. The Form Properties defines the properties of the main form and any subforms, so 
this is second. 

Third, create the controls for the form including the main form and any subforms. This includes 
placing the controls in the part of the form where you think they should be. 

Next you should select the properties of each control. This can be a tedious task at times because 
of the number of properties or of the complexity of some of them.

Then you should arrange the controls according to the layout you designed earlier. This may 
require moving some controls, adjusting some of their sizes, separating parts of the form with lines 
or boxes, selecting the background, and using text to label the form or its parts among other 
possibilities.

I recommend adding sample data to the form to test it possible problems. For example, a date 
control might be shorter or longer than needed to display the date format you want. Also, a control 
might not be formatted correctly. Once the testing is over, remove the sample data and save the 
form.

Needed toolbars
View > Toolbars produces a list of these. Most of the tools we use belong to 3 of the toolbars. 
Some of them may contain tools that no one uses, and some may have tools that are seldom 
used.

The available toolbars provide you with a wide variety of tools. Open the toolbar list (View > 
Toolbars) to see what is available.

The 3 most important toolbars are Form Controls, Form Design, and More Controls. Open the 
Form Controls toolbar first because it contains tools that open or close the  Form Design, and 
More Controls toolbars. In fact, the latter can only be opened using the control in the Form 
Controls toolbar.

If you have used toolbars before, you may know how to dock them. You dock these the same way 
as you have done them before.

However, if you have not used toolbars and do not even know what docking a toolbar means, a 
few instructions are helpful. You select a toolbar the same way you select anything in a menu: 
View > Toolbars > (name of the toolbar). For example, View > Toolbars > Form Controls opens 
the Form Controls toolbar in a floating window. You can move this anywhere on the screen by 
dragging it. However, once you dock a toolbar, the next time it opens where you last docked it.

You can drag it to the bottom of the Database Form window where it will attach itself to the bottom 
frame. This is known as docking. You can also drag it to the left or right window frame where a 
vertical rectangle appears. This indicates where the the toolbar will be docked if you drop it there. 

24 Chapter 3 Data Input and Removal



Finally, you can drag the toolbar to the top where a horizontal rectangle appears showing where 
the toolbar will dock if you drop it there.

Tip The top portion of a window containing its label is the banner.

A shortcut exists to dock a toolbar. Place the cursor on the toolbar's banner and use 
Control+double click. Where the toolbar is docked depends upon a variety of factors. Usually, it 
will dock it where you docked it before. Apparently, LibreOffice keeps this information is a 
configuration file.

How to use all of these toolbars is discussed in detail in the Writer Guide. (Remember that LO 
uses Writer to create the forms.) We will discuss how to use the 3 toolbars mentioned as these 
directly affect the form contents.

Design View steps
If you are not well acquainted with these 3 toolbars and their tools, they are below with their 
names followed by a description of each. You can also see the names or a brief description of 
what they do by moving your cursor over them. This requires a setting using the Tools menu. 
(Tools > Options > LibreOffice > General) If you check Tips, you will see the tool names. If you 
check Extended tips, you will see a brief description of what the tool will do. If you check both, you 
will see a brief description when they exist or the field name if they do not.

When working with a form, it is in one of two states: Design Mode On, or Design Mode Off. In the 
first state, you can create or edit the form, and these toolbars are available to use. But you can not 
add, delete, nor modify any of the field values. In the second state (Design Mode Off), is the 
opposite: you can add, delete, or modify any of the field values that allows this to be done. (One 
field property can prevent any changes to be made.) But you can not change the contents nor 
layout of the form.

1 Select 6 Text Box 11 Combo Box
2 Design Mode On/Off 7 Formatted Field 12 Label Field
3 Control 8 Push Button 13 More Controls
4 Form 9 Option Button 14 Form Design
5 Check Box 10 List Box 15 Wizard On/Off

Figure 19: Form Controls toolbar

1) Select: When you want to select a control or a group of controls, click this tool.

a) If the cursor is an arrow, then it is in Select mode.

b) If the arrow is any other shape, then clicking this tool will put the cursor in Select 
mode. (If you can not select what you want, click this tool and try again.)

2) Design Mode On/Off: This permits you to work between the two states of the form.

a) This is only available if you edit the form. If instead you open the form, the Form 
Controls toolbar is not available (it is grayed out if present).

b) Use this tool to see what effect the editing you have done has on the form and the 
values in the fields. For example, you have changed the date format. Using this tool 
will show you if the date field is the proper size.

3) Control: Clicking this tool opens or closes the Properties dialog for a selected control.

a) The name in the Banner identifies the object to which the properties applies.
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b) Use this dialog to define or modify the properties of the selected label or field.

c) Once the properties dialog is open, you can click another control to see its properties.

d) The properties dialog contains two or three pages (tabs) depending upon the 
circumstances. The third page contains the properties of the data when a field is 
selected. If a label is selected, it contains only two pages.

4) Form: Click this tool to open or close the Form Properties dialog for the selected form.

5)   Tools used to create controls: When any of these tools are clicked, the cursor becomes a 
cross-hair. With them you can draw a rectangle for the object you have clicked. The first 
six listed are for fields, and the seventh produces the label for any of these fields.

• Check Box (6)

• Text Box (7)

•  Formatted Field (8)

• Push Button (9)

• List Box (10)

• Combo Box (11)

• Label Field (12)

6) Wizard On/Off (13): This is useful when using three tools: List box, Combo box, and Table 
Control. It will gather information needed to define necessary properties for these types of 
controls.

• If you are going to use any of these tools, make sure this tool is turned On. (The tool 
is highlighted.)

1 Select 6 Add Field 11 Change Anchor
2 Design Mode On/Off 7 Activating Order 12 Alignment
3 Control 8 Open in Design Mode 13 Display Grid
4 Form 9 Automatic Control Focus 14 Snap to grid
5 Form Navigator 10 Position and Size 15 Guides When Moving

Figure 20: Form Design toolbar

What is shown is most but not all off the tools in the Form's Design toolbar. Six tools between the 
Alignment and Display Grid tools: Bring to Front, Send to Back, Group, Ungroup, Enter Group, 
and Exit Group. The first two are applied to overlapping objects. The last two are most often 
applied to the label and field of a control. (There are other methods of doing what the 4 grouping 
tools do, and we will discuss both when we discuss these actions.)

1) Select: The same as in the previous list.

2) Design Mode On/Off: Also the same.

3) Control: Also the same.

4) Form: Also the same.

5) Form Navigator: Click this to open or close the form navigator dialog which contains a 
hierarchical list of the form's contents. You can also use this dialog to create the main form 
and any subforms. This make it a very important tool.

6) Add Field: Click this to open or close a table list of fields. The Form Navigator settings 
determine what table's fields are listed. You can drag and drop these fields to any location.
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7) Activation Order: Click this to open or close a dialog containing the list of fields in the order 
to which they are accessed. You can change the order of the fields.

8) Open in Design Mode: This tool does NOT work. When the form is opened, clicking this 
tool should give you the ability to edit the controls and layouts of the form. It does not for 
LO 3.4.6, 3.5.6.2, nor 3.6.1.2.

9) Automatic Control Focus: When this is activated, the first field is selected automatically 
when the form is opened. (The Activation Order dialog determines what is the first field.)

10) Position and Size: Click this to open the Position and Size dialog. With this you can 
change the size, how the control is anchored, protect the size and position, and enter its 
position.

11) Change Anchor: Click this to select how the control is anchored.

12) Alignment: Use this to align a group of selected controls. 6 choices are available from the 
down arrow with this tool: 3 for horizontal alignment, and 3 for vertical alignment.

13) Display Grid: Click this to turn the grid on or off.

14) Snap to Grid: Click to turn this on or off. When it is ON, the objects are moved from one 
grid point to another.

15) Guides When Moving: Click to turn this on or off. When dragging an object with this tool 
on, dashed lines appear along each side extending to the edge of the window. This permits 
you to align it with other object or to a location on the horizontal and vertical rulers.

Tip Use Tools > Options > LibreOffice Writer > Grid to define its properties.

1 Spin Button 6 Time Field 10 Pattern Field
2 Scroll Bar 7 File Selection 11 Group Box
3 Image Button 8 Numerical Field 12 Table Control
4 Image Control 9 Currency Field 13 Navigation Bar
5 Date Control

Figure 21: More Controls toolbar

1) Spin Button: This is used for Calc and not Base.

2) Scroll Bar: This too is used for Calc and not Base.

3) Image button: Creates a button whose size you determine. You can select the graphic for 
the button and the macro associated with it using the Control tool in the Form Controls or 
Form Design toolbars.

4) Image Control: Use this to draw a control for an image field.

5) Date Control: Use this to draw a control for a date field.

6) Time Field: Use this to draw a time field. (This and the above field together is equivalent to 
a time stamp field.

7) File Selection:It creates a button that when clicked allows you to browse to a file's location 
and select it. (This is the same action as when you use File > Open.)

8) Numerical Field: This creates a numerical field.

9) Currency Field: This creates a currency field.

10) Pattern Field: This creates a pattern field. (The data entered have a specific pattern such 
as phone numbers, (123)456-7890, or zip codes, 12345-6789.
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11) Group Box: Use this to create a frame to hold a group of option buttons.

12) Table Control: This creates a table control.

13) Navigation Bar: This has limited use. In Base it activates or deactivates the tools affecting 
text in the form.

Open the Database Form dialog
To create a form in Design View, you must first open the Database Form dialog. After that open the three 
toolbars that were just discussed.

1) With the main database window open, click the Forms object.

2) In the Task section, click Create Form in Design View.

3) View > Toolbars > Form Controls and dock this toolbar.

4) In this toolbar, (Figure 19)

a) Click the Form Design tool. Dock this toolbar.

b) Click the More Controls tool. Dock this toolbar.

I am listing a series of steps required to create a form that matches your database plan and 
design. If you have a simple form that uses one table, follow the steps as they are given. The 
more complex forms containing a main form and at least one subform allows some choices to be 
made. You could work on the whole form one step at a time, or you could work on the main form 
or a subform one step at a time. 

Skip the parts of a step if it does not apply to your situation. For example, step 1 includes how to 
create a subform. If you don't have one, you skip it. Steps 3a, 3b and 3c are all methods of 
creating a control. Again, use the one you want and skip the other two when creating a control.

Caution

1) Creating a form using the Database Form dialog includes selecting the properties 
for each control. The database plan and design if done correctly will tell you what 
the properties are for each database object. Even so, diligence is necessary when 
verifying you have selected the proper properties.

2) Name and save the form when you first open the Database form dialog. You need 
to also save the main database window. When you click the Save icon in the dialog, 
you save the form to memory (RAM). Saving the main database window writes the 
form design to the hard drive.

3) As you work on the form, save it rather often using the method I just mentioned. If 
you do not do this, you may have to recreate parts or all of the form.

 Step 1: Creating the main form and any subforms

We begin using the Form Navigator tool of the Form Design toolbar. With this we select the table 
for the main form and its properties in the form. Next the Add Field tool gives us a list of the 
available controls for our selected table. After adding we want from this list, we use several tools to 
modify the layout of the main form as well as define the properties of the fields.

Figure 22: New Form

Name and save the form.

1) Click the Save icon in the database form dialog.

2) Select the main database window to activate it.

3) Click the Save icon in it.

Create a main form in Form Navigator:

1) Click the Form Navigator tool. (#5 in Figure 20) The Form Navigator dialog opens.
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2) Right click Forms and select New > Form from the context menu. A table icon and the 
word Form appear below Forms.

Tip
You can change the name of the main form or subform when you create it. Right 
after  New > Form, the name, Form, is highlighted. Type the name you want such as 
the name of the table used in the form or subform.

Subforms are created similar to a form. Right click the table icon for Form is the only difference. 
An arrow appears before the top Form showing that it has a subform.

Can you create a form with more than one main form? Yes you can by right clicking the table and 
folder icon another time. You can also create another subform of a main form. Finally, you can 
create a subform of a subform. All of these can be done by right clicking the approximate icon and 
selecting  New > Form.

Create another main form or subform in Form Navigator:

• Another main form:

a) Right click Form.

b) New > Form.

c) Form1 with a table icon appears below Form.

• A subform:

a) Right click the Form icon for which it is to be a subform.

b) New > Form

c) An arrow appears before the selected Form icon, and Form with a table icon appears 
below it.

3) Leave the Form Navigator open as you select the form properties. You will need it open 
when you add the controls to the main form or subform which is the next step.

Figure 23: New Subform

Step 2: Form Properties for the main form or subforms

We define the table to be used by the main form using the Form Properties dialog. We can open 
this using one of two methods. Use the Form Properties tool. (This is to the left of the Form 
Navigator tool.) The second method uses the Form Navigator. Right click the form whose 
properties you want to modify. Then select Properties from the context menu.

This dialog has 3 tabs. In the General tab, only the Name properties is useful to us. The Data tab 
has the properties listed in the figure above. This is the most useful to us. The Events tab contains 
the events of the form for which a macro can be assigned.

The Events tab contains events to which you can assign macros. (This is discussed in Chapter 7 
of the Base Guide.)

Tip
If you click the General tab, you see the Name property at the top. If you changed 
the name earlier, it will appear in the Name property.
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Figure 24: Form Properties dialog (Data tab)

1) Open the Form Properties dialog and click the Data tab.

• Click the Form Properties tool.

• OR, right click the Form's table icon and select Properties from the context menu.

2) Select the Content type from the dropdown list depending upon what you need to use 
(Table, Query, or SQL command). Table is the default value.

a) When Table is selected, the Content property contains a list of the created tables of 
the database. If you select Table, also select the table you will use for this form.

b) If you select Query, the Content property contains a list of the created queries. If you 
select this, select the query to be used.

c) If you select SQL command, you must enter a SQL command in the Content property. 
(The ellipse (…)  for this property opens the Query Design dialog that you can use to 
create it.) If you use this, enter the SQL command in the Content property.

3) Analyze SQL Command: This is useful only if you selected SQL Command in the Content 
type property.

• Select Yes if the Content type property is  SQL Command. Otherwise it does not 
matter.

4) Filter property: There are two ways to enter the filter property that you want:

• Enter the filter requirements in the Filter box if you know how to do so.

• Or, Click the ellipse (…) to open the Filter dialog. Enter the field name, condition, and 
value for each field used for filtering. And if using more than one field, use the 
Operator (AND, OR) that is needed.
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Figure 25: Filter dialog

5) Sort property: If you want to sort the records of the form, you have two ways to do so.

• Enter the table names and the order of the sorting in the the Sort box.

i) Enter the first field to be sorted followed by ASC (sort ascending) or DESC (sort 
descending).

ii) Enter the next field and how it is to be sorted. Repeat if necessary until you 
have listed all the fields used for sorting the data.

iii) If more than one field is used in sorting the data, enter a comma between the 
ASC or DESC or one field and the name of the next field. 

iv) Click OK.

• OR, Click the ellipse (…) for this property to open the Sort dialog. 

i) Enter the first field and its Order (ascending, descending) in the dialog.

ii) Enter the next field and its Order if there is one. Repeat if necessary.

iii) Click OK.

The final 4 properties in the Data page (tab) govern data entry for the form. 

Figure 26: Data entry properties

The first three properties determine what is allowed. The first one allows you to add new data. The 
second one allows you to make changes to an entry but not to make the entry NULL (delete the 
entry). The third property is the only one that allows you to delete an entry. The fourth property 
allows you to add new data but nothing more. The default values for these properties are Yes, Yes, 
Yes, No respectively.

6) Select the data entry properties that meet your needs.
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Figure 27: Sort dialog

7) Repeat these 6 steps for each additional form or subform.

Step 3: Creating controls

This is when you place the controls onto the form. You have tools to help you do this. Use the Add 
fields tool (Form design toolbar), Table Control tool (More Controls toolbar), or the specific tools 
(Form Controls or More Controls toolbars). The latter create controls with specific field types.

We begin by discussing the Table Control tool because it puts the fields of a table, query, or view 
into a table format (rows and columns). Next comes the Add field tool because you can insert all 
the fields of a table, query, or view one at at time. The last will be the specific tools as these create 
the labels and fields separately. Then you have to group the labels with their fields.

Once you create a control, you should determine the properties for it. Use the Control tool in the 
Form Control or Form Design toolbar (it is in both). This tool opens the Properties dialog whose list 
of properties depends upon the field type of the selected control. Because of this, I will combine 
the creating of specific controls with the defining of their properties.

After using the Table Control or Add field  tool, go to the Specific tool section for the instructions to 
define the properties of the controls. I will have a link to help you do this.

When creating controls, you should use the structure you have already created for the form. If you 
have a simple form that used only one table, query, or view, You can work on the entire form at 
one time. But when you have a complex form with a main form and subforms, you should be 
working in one of them at a time.

Step 3a: Table Control tool

This tool creates a table containing two or more controls, usually most if not all of the controls in a 
query, table, or view. The field labels become the headings of the columns, and the field entries 
become the data in the rows of the table.

When the tool is clicked, the cursor becomes a cross-hair. With it placed where you want a corner 
of the table to be, drag it to where the opposite corner should be. How large should you draw it? 
This depends upon how many fields you will place in the table and how many rows of data you 
want to be visible. The more fields the wider the table should be. Similarly, the more rows of data, 
the taller it should be.

Clearly, a large number of fields in the table is going to make it rather long. What you can do is 
create two tables: one has approximately half the fields, and the other has the rest of them. Or you 
might even divide the fields into three or more tables if necessary.

 

Figure 28: Table Control and Wizard On/Off tools respectively
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1) Make sure the Wizard On/Off tool (circled in brown) is selected. This is in the Form Design 
toolbar. Click it if it is not highlighted as shown.

2) Click the Table Control tool (circled in red) in the More Controls toolbar.

3) Move the cross-hair to where you want the top left corner of the table to appear.

4) Drag and drop it to the location for the bottom right corner of the table. (The Table Element 
Wizard –Field Selection opens.)

5) Move the fields in the Existing fields list to the Selected fields list.

• To move all the fields, click  the double right arrow.

• OR, to move a single field, select it and click the single right arrow.

6) Click Finish.

You can also create a table without using the Table Element Wizard –Field Selection. Instead you 
can use the Add field tool. If you want to do this, the instructions are below Figure 30.

Now the controls in the table need to have their properties selected. To do this go to Select the 
properties for each control.

Step 3b: Add field tool

Figure 29: Useful tools

The Add field tool (blue circle) opens a small window. It will be empty unless you have selected a 
specific table, query, or view. To create a list in this window, you must select a main form or 
subform in the Form Navigator. Click one of them and a list of fields appears in the window that 
belong to the table, query, or view associated to the main form or subform you selected. Change 
you selection in the Form's Navigator, and the list changes.

Using this tool, you can create controls on the form in 2 ways. First of all you can double click a 
field in the list to place it centered in the form. Since double clicking a field places them in the 
same place on the form, you should move the first field created this way to where you want it 
before clicking on another field. Secondly, you can just click a field in the list to select it. Then drag 
and drop it to its location.

1) Open the Form Navigator dialog if it is not open (red circle).

2) Select the form or subform that you want to work with.

3) Click the Add list tool (Blue circle) to open the field list .

4) Select one of the fields in the list to create it.

• Double click the field.

i) The field appears on the form.

ii) Use the cursor to move the control to where you want it.

iii) Repeat I and ii until you have entered all the controls for the main form or 
subform.

• OR drag and drop the desired fields from the list to where you want each to be.

Figure 30: Controls created by Add fields tool
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The label and field are both approximately 1.5” which is usually too wide. Also the label and fields 
will each have half of that length. These will be changed when modifying the layout for the main 
form or subform.

This tool can also be used to place the fields in a table created by the Table Controls tool.

1) Have the Form Navigator open and select the form or subform that will contain the table 
control.

2) Use the instructions in step 3a to create the table. (A Table Control appears below the form 
or subform in the Form Navigator.)

3) If the Table Element Wizard opens, click Cancel to close it.

4) Click the Add field tool which opens with a list of fields.

5) Drag and drop the fields onto the heading row in the order you want them to appear.

You may want to select the properties for the control you just created or wait until you have 
created all the fields for a given main form or subform. To select the properties, go to Select the 
properties for each control.

Step 3c: Create individual controls using specific tools

Using these are similar to using the Table Control tool. The tool is clicked, the cursor becomes a 
cross-hair, and you draw a rectangle, with its approximate dimensions, where you want the label 
or field.

A control consists of a label-field pair with few exceptions. (Check Box Option Button have their 
own label, so they don't need one.) But all the rest of the fields should have one for identification 
purposes. So, you should use a tool to create a field and the Label Field tool to create the label as 
a pair. Then group this label-field pair before creating the next pair. And this is how the controls for 
a main form or subform are created one label-field pair at a time.

When you create a label or field using these specific tools, it appears in the Form Navigator under 
the main form or subform you have already selected. This is done in the order that the label or 
field was created. This is why the controls should be created one label-field pair at a time: they 
will be listed together. Probably, you should create all the controls in only one way for consistency: 
the label followed by its field, or the field followed by its label. (I personally prefer to create the 
label first and its field second.)

Caution When creating individual controls, almost always create a label-field pair (label first 
and field second). Then join the pair into a single control before creating another. 
The exceptions to this occur for a check box or group box. These 2 have their own 
labels built-in while the other controls do not.

Grouping a label-field pair requires clicking one of them and Shift + click the other. The green 
handles appears around the pair. Two ways to complete the grouping: click the Group tool, or right 
click one of them and select Group from the Context menu.

The Group tool is one of 4 tools which are not visible in the Form Controls toolbar. To make them 
visible, right click any of the tools in this toolbar and then click Visible Buttons. Select Group. 
Repeat this for  Ungroup, Enter Group, or Exit Group if you think you may need to use it. If you 
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decide to use Enter Group, you should make  Enter Group and Exit Group visible. (If you enter a 
group, you also need to exit it.)

• If you are going to use these tools, make them visible in the Form Controls toolbar using 
the directions in the above paragraph. (I will use the Group tool in the instructions in this 
step.)

Below are the 4 Group tools in the Form Controls toolbar. (Group, Ungroup, Enter Group, Exit 
Group) Two are grayed out and two are available. This is because when the snapshot was taken, 
a control had been selected. When this is done, you can only ungroup or enter the group. 
Similarly, if two objects had been selected, all but the Group tool would be grayed out.

Here are the toolbars containing tools to create tools. (Some tools serve other purposes.)

1 Select 6 Text Box 11 Combo Box
2 Design Mode On/Off 7 Formatted Field 12 Label Field
3 Control 8 Push Button 13 More Controls
4 Form 9 Option Button 14 Form Design
5 Check Box 10 List Box 15 Wizard On/Off

Figure 31: Form Controls toolbar

1 Spin Button 6 Time Field 10 Pattern Field
2 Scroll Bar 7 File Selection 11 Group Box
3 Image Button 8 Numerical Field 12 Table Control
4 Image Control 9 Currency Field 13 Navigation Bar
5 Date Control

Figure 32: More Controls toolbar

There is some overlap in these tools. For example, consider the Formatted Field tool (Form 
Controls tool). A field created by it can be made into a Date, Time, Numerical, or Currency field by 
changing one of its properties.

Tip
If you have a numerical or currency field in which you want negative values to be 
red and positive values to be black, you have to use the Formatted Field tool. It will 
also enable you to select a different currency than the one used by your locale.

1) Have the Form Navigator open.

2) Select the form or subform for which you will create controls.

3) Create the label.

a) Click the Label Field tool.

b) Draw a rectangle where you want the label to be.

4) Create the field.
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a) Click the tool needed to create your field.

b) Draw a rectangle where you want the field to be.

5) Group the rectangles.

a) Click the label rectangle.

b) Shift + click the field rectangle. (The green handles surround the label and field.)

c) Click the Group tool.

Tip
 Instead of 5c, you can right click either the label or field. Then select Group from 
the context menu.

This outline tells you how to create a label-field pair and group it. How you proceed at this point 
depends upon you. You can follow #3-5 until you have created all the controls for the form or 
subform. Then select the properties for them one at a time. Or, you can select the properties for 
the control you created before creating another control. The choice is yours.

Step 3d: Select the properties for each control

Each field type has its own properties. While all of the controls share many properties, each 
control with a specific field type will have some properties that controls of another field type will not 
have. For example, a date field will have a date format while a currency will have the currency 
symbol property. Both will have the properties of position and size as well as the font used.

As a result, we will divide this step into the different field types and their properties. Each one will 
be listed in bold font.

Figure 33: Useful tools

The Control tool (circled in magenta above) opens or closes the Properties dialog which contains 
a large number of properties for the selected label or field of a control. The properties listed 
depends upon what it selected as are the number of tabs. Below are the Properties dialogs for a 
label and field. These show most of the properties but not all. (Use the vertical scrollbar to see the 
rest of them.)

As mentioned before, a control consist of a label grouped with its field. But we need to work with 
them individually. The Form design has the 4 grouping tools which we could use. This requires 
using the Enter Group tool before modifying the properties, and using the Exit Group tool when 
completed. 

We can also use keyboard shortcuts to access individual labels and fields. This requires selecting 
a control, clicking the Control tool, and Control + click the label or field. The green handles 
surround the selected label or field. The Properties dialog changes to show its properties.

Tip

When making changes to a property, you can apply it to the label or field by doing 
one of three things.

• Type Tab.
• Type Enter.
• OR, click one of the other properties. (For example, click the property above or 

below the property you just changed.

Index of tools

• Check Box

• Text Box
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• Formatted Field

• List Box

• Combo Box

• Date Field tool

• Time Field

• Numerical Field

• Currency Field

• Pattern Field

• Group Box

• Option button

• Push Button

Label Field

There is a difference between the Label Field tool and the Text Box tool. Look at Figure 31. 
Number 6 is the Text Box tool and its icon has a box around the ABC. Number 12 is the Label 
Field tool whose icon only has the ABC. (It is easy to confuse them until you use them several 
times.)

Two of the last four properties are useful for the average Base user: Word break and Help text.  
Additional information is for leaving a note about the label to someone editing the form at a later 
time. Help URL is for entering a link to a location to a part of LO's help. The URL is written in UNO.

• Name: This is the name given the label by Base. You do not change this.

• Label: This name appears in the label.  Usually, you replace Label Field with the name of 
the field in this box. 

• Enabled: Default is Yes. If No is selected, the label is grayed out and not usable.

• Visible: Default setting is Yes. This property is useful for fields in primary-foreign key pairs. 
If you don't need to see them, use this property to make them invisible. They are invisible 
when you open the form to enter, remove, or view the data. But they are visible when you 
edit the form so you can make any changes needed to them.

• Printable: If you want the label to print, accept the Default (Yes).

• Anchor: Choice of how to anchor the label. Default is To Paragraph. Other choices are As 
Character, To Page, To Frame, and To Character.

• As Character or To Character: Use one of these if you want anchor a label on at a 
specific point on a specific line in the form. Be aware that either of these requires 
more work than the next pair of choices.

• To Page or To Paragraph: The horizontal and vertical distances of a control are 
measured from where it is anchored. If it is anchored To Page, these distances are 
measured from the top left corner. If it is anchored To Paragraph, these distances are 
measured from the beginning of a paragraph, the left side of the form.

• If you have a complex form, you can create multiple paragraphs. Then select 
one of the paragraphs for each part of the form. Then you can enter a heading 
at the top of a paragraph for each part. Then anchor its controls to the beginning 
of its paragraph.

• If, like most people who accept the default setting (To Paragraph) but do not add any 
more paragraphs, the results are the same as anchoring the controls To Page. This is 
because  the beginning of the only paragraph is at the upper left corner.
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• Position and Size properties: (Position X, Position Y, Width, and Height) The position 
properties show the horizontal and vertical distance from the anchor. 

• These properties have spin buttons that change by .01 of what measure you are 
using (.01” in the snapshot). So this is a rather fine change you will be making. You 
can also highlight any of these properties and enter the value you want.

• The label will not be moved until adjustments are made when working with the form's 
layout. But write down both position values as you will need them when creating the 
label's field.

• Change the Width if the label is too narrow or wide.

• The labels created by the Form Wizard have a height of 0.20” (0.50 cm). Change the 
height to the one that applies to your locale.

• When the changes have been made, type Enter or Tab to apply the changed property 
to the label.
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Caution

1) Be very careful when using Position X or Y when working with multiple labels and 
fields. You are selecting this property for all of them at once. This can be very useful 
if you want to align some fields or labels vertically or horizontally. For the former, 
select the ones you want, enter the Position X value, and type Enter. For the latter, 
selects you want, enter the Position Y value, and type Enter.

2) Never use both Position X and Y when working with multiple labels or fields. 
This moves all of them to the same position on the form, one stacked on the other. 
Then unless this is what you wanted to do, you have to move all of them back to 
where they should be. This could take a little time.

• Font: You can change fonts to any font that has been added to your system. To change the 
font, click the ellipse (…) for the Font property. The Character dialog opens. Select the 
font, the font style, and font size from the Font tab; select the Font Effects tab to select 
what you need from there. If you want to change the fonts properties of several labels or 
fields at one time, you can select them and make the changes at the same time.

• Alignment: There are four choices, Default, Left, Right, and Center. The Default is what is 
used by the locale you have selected. For some people this will be left, and for others this 
would be right.

• Vert. Alignment: This is vertical alignment. If the label or field is tall enough, you can use 
this to place the text or an entry at the top, middle, or bottom. The following control 
demonstrates a horizontal alignment of Center and vertical alignment of Middle.

Figure 34: Center alignment for label and field

• Background color: You can select a background color from its dropdown list, or you can 
click the ellipse (…) to open the Color Picker dialog. From it, any color can be created and 
used.

• The top choice of the dropdown list is Default which is no color at all with my 
operating system.

• Border: (Without Frame, 3-D, or Flat) Select these choices to see which one you prefer 
and then select it.

• Border color: When you select Flat Border, a line is drawn around the label or field. This 
property permits you to select the color of that line. You have the same dropdown list and 
ellipse (…) as for Background color.

• Word break: This is for the labels. When they contain more than one word, you can use 
this property to display the words on multiple lines. Use Enter+Shift to create the additional 
lines, but first you have to use the Height property to make the label tall enough.

• Additional Information: Here you can leave yourself or others a note about the selected 
control. It is only available when the form is edited, the control is selected, and the 
Properties dialog is opened. 

• Help text: Use this to enter instructions or descriptive information about this control.

• Help URL: Written in UNO. This is used in documents , and the link points to a part of the 
Help files.
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The label properties are contained in 2 tabs: General and Events. What we have written applies to 
to the General tab only. (The Events tab is used when including a macro to the form. This is 
discussed in chapter 8 of the Base Guide.)

The rest of these are field properties, and they are contained in 3 tabs: General, Data, and Events. 
The Data tab contains a few properties that refer to the data contained in the field. The General 
tab for fields has many of the same properties as for the Label Field. A few additional properties 
are added that are specific to the field type of the selected field.

Tip
Since many of the General properties are the same, we will discuss only the 
additional properties that a specific field type adds to it. Use the guidelines in Label 
Field for the common properties.

Common field properties

Tab Order

As the form is created and each field added, the Form Navigator adds it to the list of fields in the 
main form or subform, and they are ordered from first one created to the last. From this Base 
creates an ordered list of the fields in the main form or subform. If you have entered on of these 
fields, you can move to the next field in this ordered list by using the Tab or Enter key. When you 
reach the last field in the list, using one of these keys will take you back to the top of the list and to 
the next record. If you came from the last record, the use of one of these keys will open a new 
record.

You can move up the ordered list by using the key combination, Shift + Tab. When you reach the 
top of the list and do this, you are taken to the last field of the list and to the previous record. Once 
you reach the first field of the first record, you can not go any further.

• Tabstop: (Yes/No) Yes is the default value, and you can navigate though the fields to this 
field. If you select No, this field will be skipped as you navigate through the fields. 

• Tab order: This only works when the Tabstop property is Yes. If you want to do so, you can 
use this property to number the tab order for all the fields. If you only have a few fields, it 
might not matter, but numbering 70 fields from 1 through 70 is unnecessary time 
consumption (personal experience). A better way: click the ellipse (…). This opens the Tab 
Order dialog.

• Move Up button: Select the name of a field to be moved in the list. Click the Move Up 
button to move it up one place at a time. To move a field 3 places, you have to click 
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this button 3 times. If you select more than one field, you can move both at the same 
time.

• Move Down button: This works the same way: select a field and then click the button 
to move the field further down the list.

• Automatic Sort: The sorts the fields according to their position on the form. 
Sometimes this works well, and sometimes it does not.

Mouse wheel scrolling

The Mouse wheel scroll property determines what happens when the cursor is in the field and you 
scroll the mouse wheel. For many fields, scrolling the wheel will increase or decrease the value 
contained in the field. The choices are Never, When focused, and Always.

Click this link to return to Index of tools used to create labels and fields.

Caution I recommend that you use the Never choice. Then the mouse wheel will not change 
any data. And considering that you could have the cursor in one part of the form but 
your attention is drawn to another part, you could change the data without even 
noticing it.

Check Box

• General Tab:

• Label Field: Since the Check Box has a label, you can leave this property blank.

• Tab stop and Tab Order: see Common field properties.

• Default Status: The choices are Selected or Not Selected. Selected will place a check 
in the box until it is changed; Not Selected will cause the box to be empty until it is 
checked.

• Style: The choices are flat or 3D. It does not really matter for this field as there is no 
noticeable difference.

• Graphics: Use this to add a graphic to the Check Box field if you want. To do this, 
click the ellipse (…) and browse to the graphic file. Use a thumbnail or very small 
graphic. (Below is an example.)

• Graphics Alignment: This determines where the graphic will be placed. In reality, 
unless you want the Check Box field to be large enough to hold the graphic in a 
portion of field, changes in alignment very seldom produces a visual effect. Graphics 
Alignment should be used with Alignment and Vert. Alignment. (The above example 
has Alignment (Left), Vert. Alignment (Default), and Graphics Alignment (Centered).

• Tristate: In the past, a check box could have 1 of 2 values: Yes or No. Now, 3 values 
are possible: True, False, or 0 (zero). Visibly in a check box you see dark check, a 
grayed out check, or an empty box respectively. If you want three values, change the 
dropdown list to Yes. (Normally you would use an option button instead of a check 
box for three values.)

The Data tab has 4 properties: Date field, Input required, Reference value (on), and Reference 
value (off). 

• Date field has a dropdown list of fields based on the main form or subform selected in the 
Form Navigator. So, select the field that needs a check box. 
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• Input required determines whether you must enter data immediately in this field or not. 
Sometimes we require data be entered into the field before you can go to the next field. In 
this case, select Yes. Other times the data needs to be added later. For example, a form 
that contains financial transactions, and it includes a check box we use to check the 
entries against a financial statement.

• Reference value (on) and Reference value (off): Enter the value when the box is checked 
and not checked respectively. These values can be Yes and No, True and False, or 1 and 
0. Or, you can use any pair of text phrases that you will understand. Place values in both 
properties. 

Click this link to return to Index of tools used to create labels and fields.

Text Box

Use this any time you need to enter text into the database. Most of the uses contain only one line 
of text. Fields whose field type is Memo, can have multiple lines and scrollbars (usually vertical).

Here we discuss only the properties that differ from the Label Field. Use this link, Label Field, to 
return to that section. Make sure you write down this page number so you can return here.

• Max. text length: Default is 0. Usually, this requires no adjustments as the field properties 
in the field's table defines the text length for text. And if you need to increase the possible 
text length, edit the field's table to correct it. However, you can change this property if 
necessary. Just remember that the field will not store a longer text string longer than what 
is defined in the field's properties.

• Read only: The default is No. But if you have text that you do not want to be changed, 
change the setting to Yes. For example, you have a primary key that is auto-generated 
which you also want to make visible. This is a value that you do not want anyone to 
change.

Note
The Read only and Tabstop properties can be used together. Setting both to No 
means that the data can not be modified nor deleted nor can anyone navigate to 
this field using the Tab or Enter key.

• Default text: This serves the same purpose and it does in the field properties: you can 
enter the default text in either property. But you do not want to enter text in both of them. 
What you enter in the field properties when you created the field in its table is what 
appears in the field in the form. If you were to enter something in the Properties dialog 
after entering something different for the field, the latter will appear in the field in the form.

• Border: There are three types of borders: without frame, 3D, and flat. The first choice has 
an invisible frame, 3D has a designed frame, and the last choice has a visible frame. 
Select the border you want to use. (I prefer 3D since this accents the fields in my forms.)

• Border color: This is only available when you select the flat border. This has a dropdown 
list containing the color table, and the ellipse (…) opens the Color Picker dialog where you 
can create any custom color you want.

• Text type: single-line, Multi-line, and Multi-line with formatting

• Single-line: Select this to require the text fit on one line only.

• Multi-line: Select this if you allow entries involving multiple lines.

• Multi-line with formatting: Use this when you are copying formatted text to the field. 
The amount of formatting that is accepted is limited. Bold and italic text copy well. 
First line indent style does not, nor do bullets copy. But if you copy and paste a list 
with bullets, the text does maintain the indentation of the list.

• Text line ends with: In multi-line text, this determines what goes in each line. Select the 
one that matches the OS running the computers on which they run this database.
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• LF (Unix): This is a line feed that Unix and Linux use.

• CF and LF (Windows): This is a combination of a carriage return immediately 
followed by a line feed. This is for databases that are used on Computers with a 
Windows OS.

• Scrollbars: Choices are None, Horizontal, Vertical, and Both. This in only available when 
you have selected Multi-line in the Text type property. (2 properties up)

• Password Character: Use this property for a field that contains a password. Enter the 
character that you want appear instead of the password when it is entered. The most 
common character used is an asterisk (*). However, you can use any character that you 
want to use (letters, digits, punctuation). 

The Data tab contains four items: Data field, Empty string is NULL, Input required, and Filter 
proposal. Be careful how you used the middle 2 properties. If you select Yes in Empty string is 
NULL, you must select No in Input required. 

Click this link to return to Index of tools used to create labels and fields.

Formatted Field

This is a somewhat generic field. You can create a variety of fields with different fields types (date, 
time, numerical, currency). What you select in the Properties dialog determines the field type that 
the field will accept.

Here we discuss only the properties that differ from the Label Field. Use this link, Label Field, to 
return to that section. Make sure you write down this page number so you can return here.

Formatting: The selection of the the formats to be used in the field is done in the Number Format 
dialog. The top contains two lists: Category and Format. Below them is the Options section where 
you can modify the format to be used. And at the bottom is the Format code box.

The language used partially determines the format for the field. So, if you have a field that requires 
using a format based upon the language, this dropdown list permits you to select it.

To help you as you make your Category, Format, and Language selections, you have a box 
showing the format that you have selected. This is directly below the Language dropdown list.

The Option section contains 4 choices. You can use the Decimal places box to change this 
number.

The Leading zeroes box is useful useful if you want all the numbers to have the same number 
digits to the left of the decimal point. You can enter this number in this box. Then for numbers with 
fewer digits, zeroes are added at the beginning of the number until it has the required number of 
digits. For example, I enter 3 in the box. 1 would be shown as 001, 23 as 023, 999 as 999, and .25 
as 000.25. Now all these numbers have three digits to the left of the decimal point. If the number 
has as many or more digits than the number you listed, the number appears without any change in 
appearance made.

The other two options are self-explanatory. Check the first check box, and negative numbers 
appear in red font. Check the second; click the second and thousands separators appear in 
numbers large enough to need them.

When you select a category and format in the lists at the top, their code appears in this box. You 
can modify this code to modify the format. If you select the User-defined category, you can enter 
code in this box to define the format you want to use. (Use the codes listed in Help.
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Tip

LO's help section contains list of different format codes you can use. If you have 
LO online help, open Help using the F1 key. Enter Common/Number Format. If 
you have downloaded and installed the Help files, type F1 to open Help. Click the 
Index tab and enter number format which highlights this phrase. Click Code just 
below it and then click the Display button at the bottom of the Help window.

The spin button places a spin button at the right side of the field. This is used only when a 
numerical category has been selected in the Number Format dialog. Click the up arrow to increase 
the value in the field, or click the down arrow to decrease it.

Repeat: This changes the properties of the spin button. Select Yes if you want to hold the spin 
button down to continue to increase or decrease the value in the field.

Figure 35: Number Format dialog

• Formatting: In the Formatting property, click the ellipse (…). Select the category and then 
format that the field should have. 

• Change the language if needed.

• For number formats, 

• Enter the number of decimal places and leading zeroes needed.

• Select whether you want negative numbers to appear in red or thousands 
separators added when needed.

• Format code:

• Number Format codes: Numbers consist of columns of digits, each one having a 
specific place value. Use a 0 in a column if a 0 should be used as a place 
holder. Use # in a column if a digit should only be used if it is in this column of 
the number.

• Decimal places: Use a 0 or # in columns to define the maximum number of 
decimal places that will be shown. Any number containing a greater 
number of decimal places will be rounded to the decimal places you set. If 
a number has fewer, then the field shows the number as it is when the # is 
used. Use the 0 instead, and zeroes will be put in the decimal places that 
are not contained in the number. (.5 becomes .5 when using #.##, or .50 
when using #.00, or 0.50 when using 0.00.)

• Thousands separators: Add them to the number's code. #,### or 0,000 or 
combinations of them define this format. The first code will add a comma 
before  every third digit to the left of the decimal point of a number. The 
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second code will do the same thing. It also adds the requirement that the 
thousands and hundreds places must have a digit. If the number does not 
have one of these a 0 is used as a place holder.

• Special thousands separator: It can be used to reduce the number digits of 
the displayed number by 3. Each additional one added further reduces the 
digits of the displayed number by an additional 3. ( #, reduces 1,234,567 
to 1,235. #,, reduces it to 1.)

• Text and numbers: You can add a text prior to or after the number. This is 
useful when putting a measurement label with a number. When using this, 
make sure you include any spaces that you want between the number and 
text. Use double quotes around the text or use a back slash before it. This 
only put text where you want it. You have to also use the format code for 
the number as well. (#.## “inches” is the same thing as #.## 
\inches.) If you need to use a phrase containing at two words, you 
should use the double quotes.

• Spaces: You can define the size of the space you use in the field. Different 
letters have different widths. Placing an underscore (_) before a letter 
creates a space that has its width. _w gives you one of the wider spaces, 
and _i will give you one of the narrower spaces.

• Color: You can select red for negative numbers in the Options section. You 
can select additional colors as well. You put the name of the color in 
brackets [ ] to do this. Your choices are colors are CYAN, GREEN, BLACK, 
BLUE, MAGENTA, RED, WHITE, and YELLOW. There is a reason why I 
used capital letters for these colors: you use them when entering their 
name in the brackets. ([RED]0 will produce red numbers; [GREEN]0 will 
produce green numbers. 

• Conditional brackets: (Producing colored numbers is an example of this. 
The color name in the brackets defines what will happen to the number 
format that follows.) You can use any combination of numbers and the <, 
<=, >, >=, = and <> operators to define your condition. If you have more 
than one condition, you separate them using a semi-colon. For example, 
we want positive numbers and 0 to be green and negative numbers to be 
red. [GREEN][>=0]0 gives you green digits for non negative numbers. 
[RED][<0]0 gives you red digits for negative numbers. Combine these 
with a semi-colon to get non negative numbers in green and negative 
numbers in red. [GREEN][>=0]0;[RED][<0]0.

• Currency: This is usually set by the language selected in the 
dropdown list at the top.  But you can also use conditional brackets to 
do this. Use [$xxxnnn]. The $ specifies that this is a currency 
condition, the xxx is the currency symbol, and the nnn is the country 
code.

• 0.00;[RED]-0.00 This is another code for positive and negative 
numbers. In this case, they have 1 leading zero, 2 decimal places, 
default color (black) for not negative numbers, and red color for 
negative numbers.

• When using multiple conditions for numbers, the first one applies to 
positive numbers, the second one applies to negative numbers, and 
the third one applies to 0. You can change this by using a pair of 
brackets to define what numbers are included. [<30.2] This 
includes all numbers less than 30.2.
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• Text and conditions: 
[BLUE]”plus”;[RED]"minus"0;[MAGENTA]"null"0.
8 will be plus 8; -8 will be minus 8, and 0 will be 0.

• Percent: annex the percent sign to the format code. For example, the latter 
is #0.00. To change this to percent, the code becomes #0.00%.

• Date formats: The Format list has many entries, so you may not need to create 
the format code you need. If you do need a special date format, study the format 
codes for the entries that have part of what you need. Often you can combine 
parts from existing codes to create yours.

• You can also use brackets for a condition to define the calendar to be 
used. A couple of the most common calendars are Jewish and Arabic. The 
format code for this is [~language]. Help has a list of the choices you have. 
Also, near the bottom of the Format list, there are some entries which use 
this code.

For example, My date format should be Sun Oct 22, 2013. In the list I see the following codes: 
NNN is the 3 character code for the day of the week, MMM is the 3 character code for the month, 
DD is the 2 character code for the day of the month (I could use D instead of DD so day 2 appears 
as 2 rather than 02), a comma to place after the day, and YYYY is the 4 character code for the 4 
digit year (I could use YY to display the last 2 digits of the year).

Tip

The formatted field tool will create a field with a variety of field types depending 
upon what you select in the Number Format dialog. This usually will define more 
properties for the field than the equivalent special tool. These may or may not be 
significant depending upon your needs. For example, using a format code is not 
available in any of the special tools. For the number field type fields, different colors 
are not available for positive and negative numbers. You can only select this using 
the formatted field tool.

Click this link to return to Index of tools used to create labels and fields.

List Box

Use this tool when you want the field to contain a dropdown list from which you select an entry. 
The source for the dropdown list can be a database table or query, or you can list its entries in the 
General or Data tab in the List entries property.

There are two types of dropdown lists that you can create. In one you want to select from the list 
the entry that will be made in the field. In the other, what you select from the list determines what 
is entered. In this case what is selected is not what is entered.

For example, the field which has the dropdown list contains an identification number. The list table 
contains people's names and identification numbers. Using this table, we can select the person's 
name from the dropdown list and enter his identification number in the field at the same time.

We discuss the creating of a list box with the same selection in the dropdown list as entered in the 
field. At the end we discuss how to have select one value from the dropdown list while entering the 
associated value in the field.

This is one of the times when having the Wizard On/Off tool selected. After drawing the outline for 
the list box field, the list Box Wizard dialog opens. Using this, you can select the table or query 
and a specific field to be used as the data source for the field you just created.

With the Wizard On/Off tool turned off, you can use the Control tool to define the properties for the 
list box. This requires making selections in both the General and Data tabs.

There is another possibility that must be considered when the main form or subform use the Data 
Sheet format which looks like a table with the fields being its column headings. When any of these 
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need to be a list box, the field has to be replaced with a list box field. You can not use the wizard to 
do this, but you can use the process described in the previous paragraph.

This list describes how to create a list box field and define its properties using the wizard. The next 
list describes how to do this without using the wizard.

1) Open the Form Navigator and select the form or subform that will contain the list box.

2) Make sure that the Wizard On/Off tool is selected (highlighted).

3) Click the List Box tool (Form Controls toolbar) and draw the field's outline where you want 
it. The List Box Wizard dialog opens.

Figure 36: Label and Field 
for a list box

4) Selecting the list box properties:

a) Click the table or query that provides the data source for the list box field. (The Form 
Navigator selection determines what tables or queries appear in the dialog.)

b) Click Next.

Note

When we created the tables to be used as the data sources for list boxes, they each 
contained one field. This is why the Field Selection page only has one field listed. 
This arrangement also guarantees that the dropdown lists will always be in 
alphabetical order.

c) From the list of fields of the selected table or query, click the field that contains the 
data source for the dropdown list. This enters the field's name in the Display field box.

d) Click Next.
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e) In the left list, click the field name that matches the label for this list box. 

i) This is the name of the field into which the data of the list box will be entered.

ii) The field name appears in the box above the list.

f) In the right list, click the field name to place its name in the box above this list.

g) Click Finish.

It always pays to verify what you have done. In this case, you should look at the properties of the 
list box field to see is everything is accurate.

5) Verifying that the list box field properties are correct.

a) Click the Control tool to open the Properties dialog (Properties – List box).

b) Click the Data tab.

i) Input required: Select Yes or No according to your plan.

ii) Type of list content should be Sql.

iii) List content should be SELECT "field name" FROM "table name". If 
it has SELECT "field name","field name" FROM "table name", 
change it to what it should be.

iv) Bound field: Since the list table contains only one field, it does not matter what is 
in this box. (It will probably have the number 1.)

Tip
For the Bound field property: If the list table has 2 or more fields, number its fields to 
get the number for the field used for the dropdown list. Subtract 1 from this number, 
and enter the result in the Bound field property box.

Instead of using the list box wizard, we can define the properties using the Control tool to define 
the elements of the dropdown list.

1) Open the Form Navigator and select the form or subform that will contain the list box.

2) Make sure that the Wizard On/Off tool is not selected.
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3) Click the List Box tool (Form Controls toolbar) and draw the field's outline where you want 
it. (If the wizard opens, click Cancel.)

4) Click the Control tool.

a) Click the Data tab.

i) Data field: Select the field for the list box.

ii) Input required: Select Yes or No depending upon your plan.

iii) Type of list contents: It should be Value list. Change it if it is not.

iv) List contents: Enter the list of names for the dropdown list using Shift+Enter 
between names. When all names have been added use Enter to apply them.

b) Click the General tab.

i) Mouse wheel scroll: Select Never.

ii) List entries: You can use this instead of the list contents property. The names 
are entered the say way here as in the Data tab.

iii) Dropdown: Change this to Yes and use Enter. This places the arrow at the right 
end of the field indicating it contains a dropdown list.

If you have created main form or subform using the Table Control tool, you can also create a list 
box. The type of field has to be changed to a list box, and its properties defined. This time we are 
going to use SQL to define the field that provides the elements of the dropdown list. The SQL 
statement tells Base what table (“table name”) and which of its fields (“field name) to use for the 
dropdown list.

Note
The List entries property has an ellipse which you can click. This opens the Query 
Design dialog which you can use to select the field. This is discussed in the query 
section of chapter 4 of the Base Guide, Data Output.

1) Right click the field to be made into a list box field.

2) Select Replace with > List Box.

3) Click the Control tool to open the Properties dialog (Properties – List box).

a) Click the General tab.

i) Mouse wheel scroll: Select Never.

ii) Dropdown: Change this to Yes and use Enter. This places the arrow at the right 
end of the field indicating it contains a dropdown list.

b) Click the Data tab.

i) Data field: Select the field for the list box.

ii) Input required: Select Yes or No depending upon your plan.

iii) Type of list contents: Change this to Sql.

iv) List contents: Enter the following: SELECT "field name" FROM "table 
name".

v) Bound field: Since the SQL statement defines the field, do not make any 
changes.

So far, our list box field contains the same value as is selected in the dropdown list. This 
guarantees a uniform entry when we enter specific values repeatedly. It also guarantees that our 
reports containing a list box field will have the same values as found in the dropdown list.

There is another possibility of repeated values that we need to consider. We may be entering the 
same data repeatedly, but the data may differ very little making it difficult to select the correct entry 
from the dropdown list. For example, we have a field, Student ID with a dropdown list. The latter 
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contains Student Identification numbers. These are several digits long and can differ by only one 
digit. If we have a table that contains all the student names and their identification numbers, we 
can use the names to select the corresponding numbers. To do this we use the Bound field 
property.

To accomplish this, you first create the list box using any of the methods mentioned above. Then 
enter a modified SQL statement in the list contents property. Finally enter the digit 1 in the bound 
field property.

1) Create the list box using any of the methods already mentioned. This includes selecting 
the properties as outlined in the method you use. Leave the properties dialog open.

2) Click the Data tab if it is not already selected.

3) Modification to be made in the Data tab:

a) Type of list contents: Change this to Sql (if it is not already selected).

i) List contents: Enter the following: SELECT "field name1", "field 
name2" FROM "table name".

ii) Bound field: Set this property to 1

There is a reason for the SQL statement to be worded the way it is. Base uses the first named 
field for the dropdown list, and the second named field for the list box field.

Using our example that involved in the Student ID field. The list box table, Identification, contains 
two fields: ID, and Student Name. We want to select a student name in the dropdown list and to 
enter the corresponding Student ID in the Student ID field. The SQL for that would be: SELECT 
"Student Name", "ID" FROM "Identification". Then we set the bound field to 1.

Base then uses the first field, Student Name, for the dropdown list and the second field, ID, for the 
corresponding values for the Student ID field.

Click this link to return to Index of tools used to create labels and fields.

Combo Box

A combo box is very similar to a list box. The main difference is that a list box permits you to select 
only predetermined values from the dropdown list. With a combo box you can enter values that 
differ from the elements of the dropdown list.

Note
A combo box can be made to behave just like a list box by changing the Read only 
property from No to Yes.

A combo box can not display one value from the dropdown box and enter the corresponding value 
in the list box field. This is because it does not contain a bound field property. List boxes can do 
this because the do have this property.

A combo box is created is the same way as a list box, and you can use any of the methods 
mentioned in List Box. A couple of differences are listed here. One involves the Combo Box 
Wizard, and the other involves the Data tab of the Properties dialog.

If you have the Wizard On/Off tool highlighted (Form Controls toolbar), drawing the outline of a 
combo box opens the Combo Box Wizard. In the first page select the table that contains the field 
for the dropdown list.
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Figure 37: Selecting the table for the dropdown list in a combo box

In page 2, click that field to select it. Its name appears in the Display field box.

On page 3, you have a choice of what you want to do with the combo box. This is because a 
combo box can serve two purposes: to enter data from the dropdown list into a field (top choice), 
or to only show a selected value (bottom choice).

Select the top choice to save the selected value in a database field just as is done in a list box. 
With this selection, you have to also select the field from a dropdown list.

Select the bottom choice only if you want a dropdown list as a label in a part of the form. If this is 
the case, you also want to change the the Tabstop property from Yes to No. Whatever value you 
then select from the list remains until you change it.

The final difference is the SQL statement. But for most of them, the dialog will be too narrow to 
hold it all on one line. So first widen the dialog and then write the SQL.

The format for it is SELECT DISTINCT "field name" FROM "table name". The reason for 
the keyword  DISTINCT: fields can have the same value multiple times with the exception of the 
primary key. To make sure the list has only distinct values, this keyword is used in the SQL.
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Click this link to return to Index of tools used to create labels and fields.

Date Field tool

There are 5 properties you can modify in the General tab and 2 properties in the Data tab. These 
permit you fewer choices and selections than are available when using the Formatted Field tool. 
So, you need to decide which tool will benefit you the most. Fields with a timestamp field type 
should be created with the Formatted Field tool.

The 5 properties are Date min, Date max, Date format, Default date, Spin button and Dropdown. 
Date min and max together determine the range of dates permitted in the field. All dates have to 
be on or before the date max entry; all dates have to be on or after the date min entry.  Date 
format has a dropdown list containing many of the date formats. The Default date is the date that 
appears in the field until you change it. The Spin button allows you to change the date forward of 
backward. The  Dropdown property for a Date field is similar to a list or combo box. When you 
click the arrow in the field, the latter 2 produce a dropdown list. When you click the arrow in the 
field, a date field produces a calendar from which you can select a date.

In the Data tab, you select the field that contains dates first. Then select whether the field must 
have a an entry in every record or not.

1) Have the Form Navigator open and the main form or subform selected that you are 
working in.

2) Have the Properties dialog open. (Click the Control tool to do this if it is not already open.

3) Click the Date field tool and draw the outline of the field where you want it.

4) Click the General tab if it is not already selected.

5) In the Label field property, click the ellipse (…) to select the label that belongs to the field.

6) Date properties:

a) Date min: Modify this date if necessary to the oldest date permitted in the field.

b) Date max: Modify this date if you want all dates to be on or before the date you enter 
here.

c) Date format: Select the one you prefer from the dropdown list.

d) Default Date: If you have a date that should appear in the field until it is changed, 
enter it here.

e) Spin button: Enter Yes if you want to change the date using it.

f) Repeat: Select yes if you want the spin button to repeat for a long as you hold it 
down.

g) Dropdown: If you want a calendar to appear when you click the field's arrow, change 
this to Yes.

7) Click the Date tab

8) Date field: Use the dropdown list to select the the field.

9) If you want to require an entry for this field in every record, accept the default setting (Yes). 
If an entry is not always required, change it to No.
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Click this link to return to Index of tools used to create labels and fields.

Time Field

This has 5 properties in the General tab and the same two in the Data tab (the same ones as for a 
date field). This tool creates fields that contain time only. For a timestamp, use the Formatted Field 
tool. Also use it if you want format time more than is available using this tool. (See below for the 
choices available.)

The The General tab properties are Tim min, Time max, Time Format, Default time, and Spin 
button. Tim min, Time max refer to the range of time permitted. Time Format has 4 formats: hours 
and minutes; hours and minutes with AM/PM; hours, minutes, and seconds; and hours, minutes, 
seconds and AM/PM. Default time is used for the time to appear in every record until it is changed. 
With the spin button, you can change the time using a spin button.

1) Have the Form Navigator open and the main form or subform selected that you are 
working in.

2) Have the Properties dialog open. (Click the Control tool to do this if it is not already open.

3) Click the Time field tool and draw the outline of the field where you want it.

4) Click the General tab if it is not already selected.

5) In the Label field property, click the ellipse (…) to select the label that belongs to the field.

6) Time properties:

a) Time min: Modify this date if necessary to the oldest date permitted in the field.

b) Time max: Modify this date if you want all dates to be on or before the date you enter 
here.

c) Time format: Select the one you prefer from the dropdown list.

d) Default Time: If you have a date that should appear in the field until it is changed, 
enter it here.

e) Spin button: Enter Yes if you want to change the date using it.

f) Select yes if you want the spin button to repeat for a long as you hold it down.

7) Click the Date tab

8) Data field: Use the dropdown list to select the the field.

9) If you want to require an entry for this field in every record, accept the default setting (Yes). 
If an entry is not always required, change it to No.

Tip
If you use the spin button with this field, you can change the hours, minutes, or 
seconds by clicking in the specific parts of the time and one of the spin buttons.

Click this link to return to Index of tools used to create labels and fields.

Numerical Field

This tool creates a field with the following special properties: Value min, Value max, 
Incr./decrement value, Default value, Decimal accuracy, Thousands separator, Spin button, and 
Repeat.

Together Value min and max define the range of possible numbers the field will accept. The 
selection made in the field properties when its table was created also affect what can be used. The 
stricter property will be used.

 Incr./decrement value (increment/decrement value): this determines how much of an increase or 
decrease occurs in the entered value when the spin button is clicked. This value can be positive or 
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negative. It is limited to Integers though; for example, you can not use 0.1 or .0009 for this 
property.

Default value: If you have a value you want the field to have until you change it, enter it here. You 
could have entered this value in the Field properties of this field when you created it in the Table 
Design dialog.

Decimal accuracy and Thousands separator: The former determine how many digits will appear to 
the right of the decimal point. The latter groups the digits to the left of the decimal point into threes. 
The locale you selected when you installed LibreOffice will determine what will be used as the 
decimal point and thousands separator.

Spin button, and Repeat: The former creates a spin button at the right end of the field with which 
you can change the entered value by clicking. The latter affects the behavior of the spin button. 
Selecting Yes for this property causes it to continue to increase (up button) or decrease (down 
button) the entered value for as long as the spin button is held down. (The value will not exceed 
the Value min nor max though.)

1) Have the Form Navigator open and the main form or subform selected that you are 
working in.

2) Have the Properties dialog open. (Click the Control tool to do this if it is not already open.

3) Click the Numerical field tool and draw the outline of the field where you want it.

4) Click the General tab if it is not already selected.

5) In the Label field property, click the ellipse (…) to select the label that belongs to the field.

6) Numerical properties:

a) Value min: Modify this date if necessary to the oldest date permitted in the field.

b) Value max: Modify this date if you want all dates to be on or before the date you enter 
here.

c) Default Value: If you have a date that should appear in the field until it is changed, 
enter it here.

d) Spin button: Enter Yes if you want to change the date using it.

e) Repeat: Select yes if you want the spin button to repeat for a long as you hold it 
down.

7) Click the Date tab

8) Data field: Use the dropdown list to select the the field.

9) If you want to require an entry for this field in every record, accept the default setting (Yes). 
If an entry is not always required, change it to No.

Click this link to return to Index of tools used to create labels and fields.

Currency Field

When a field is created with this tool, its properties are identical to those of a numerical field. The 
only difference is the Currency symbol property which shows the symbol that will be used. This is 
based on your local. If you want to change that use Tools > Options >  Language Settings > 
Languages.

• Follow the steps for selecting the currency properties in Numerical Field.

Click this link to return to Index of tools used to create labels and fields.

Pattern Field

Use this tool when you want to a specific format to appear in the field. For example, telephone 
numbers [(555) 555-5555], zip codes [11111-1111], or social security numbers [111-11-1111].
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The pattern field property contains two properties that define the appearance of it: Edit mask and 
Literal mask. The Edit mask consists of codes, and the Literal mask consist the actual layout in 
characters.

A given code determines what is permitted in the position of the code. By entering codes in a 
sequence you determine what appears in the field.

There are 8 codes used in the Edit mask:

• L: This is a text constant. This is for the placement of characters used for formatting.

• a: Use this when you want to see a-z and A-Z in this position. (A-Z only)

• A: Use this to see all capitals regardless of the case typed.

• c: Use this to show a-z, A-Z, and 0-9 in its position

• C: Use this to show A-Z and 0-9 only.

• N: Use this to show 0-9 only.

• x: Use this if you want to include all possible printable characters regardless of case.

• X: Use this to show all possible printable characters with upper case used wherever 
possible.

The Literal mask uses an underline ( _ ) for each allowable character to be entered.

Perhaps a few examples will help with this formatting concept:

• LNNNLLNNNLNNNN with (___) ___-____ shows (123) 456-7890. The first L matches the 
opening parenthesis. The first NNN require 3 digits to be entered. The second L matches 
the closing parenthesis. The third L matches a space. The next NNN requires 3 digits to be 
entered. The fourth L matches the hyphen. The NNNN requires 4 digits to be entered.

• The entry in the pattern field for this phone number is 1234567890.

• LNNLLNNLLNNNNN with +__  __  _____ shows +12  34  56789. The first L matches the 
+. The first NN require 2 digits to be entered. Both LL match the double spaces uses within 
the phone number.

• The entry for this phone number is 123456789.

• Postal code examples:

• NNNNNLLNNNN with _____--____  shows 12345-6789. The NNNNN requires 5 
digits, and the NNNN requires 4 digits. The LL matches the double hyphen. (In the 
field on the form, they appear as a m dash.)

• NNNNNLLNNNN with _____--0000 shows 12345-0000. The NNNNN requires 5 
digits, and the NNNN requires 4 digits. The LL matches the double hyphen. (In the 
field on the form, they appear as a m dash.)

• CCCLLCCC  with ___--___ shows  AB1 2CD. Both CCC require three letters or  
numbers, and the LL match the double hyphen. Also, using the C requires only capital 
letters and 0-9 be used.

The next property, Strict format, is very important for this field. It should be Yes because you want 
the entries to exactly follow the  two masks that you have entered. Otherwise what is entered by 
someone may or may not be what you want.

With this consideration, you should also have a short text near the field showing the format you 
are expecting. This will make things easier for the person entering the data. For example, every 
time I see a database form requesting my phone number, I wonder how they want me to enter it. 
Some prefer 10 digits, others format it in various ways. This will be mentioned when we discuss 
how to layout a form.

1) Have the Form Navigator open and the main form or subform selected that you are 
working in.
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2) Have the Properties dialog open. (Click the Control tool to do this if it is not already open.

3) Click the Pattern field tool and draw the outline of the field where you want it.

4) Click the General tab if it is not already selected.

5) In the Label field property, click the ellipse (…) to select the label that belongs to the field.

6) Edit mask: Enter the code for each character for this mask.

7) Literal mask: Enter an underline ( _ ) for each character to be entered and any characters 
that will be shown in the field but not entered. (Compare the first 2 postal codes.)

8) Strict format: Change this to Yes if it is not.

Click this link to return to Index of tools used to create labels and fields.

Group Box

This tool will create a field that contains option buttons. By clicking one of these, an entry is made 
in a field. (Option buttons are mutually exclusive selections whereas using multiple check boxes 
are not.)

This does not require a label since the second property in the Properties dialog will give the group 
box a label. Also, the label options are added if you use the wizard for selecting the the options 
and the values they have when selected.

You can create the same field with option buttons by creating the individual option buttons and 
grouping them together similar to grouping a label-field pair. However, using the wizard is quicker 
and requires fewer steps.

This is how you use the wizard to create a group box.

1) Click the Wizards On/Off tool at the right end of the Form Controls toolbar. 

2) Click the Group Box tool in the More Controls toolbar. 

3) Create the Option fields:

a) Enter a name in the box.

b) Click the right double arrow (to the right of the box). This adds the name to the Option 
fields list.

c) Repeat a and b until all the option names are created.

d) To remove a name from the Option fields list, click it and then click the left double 
arrow.

4) Click Next.
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5) Select the default field (if any):

• If you want to have an option as the default, click the Yes option button and select the 
name in the dropdown list.

• If you don't want a default option, click the No option.

6) Click Next.

The wizard by default assigns a number to each Option field beginning with 1 at the top. Feel free 
to change the numbers to whatever you need.

Usually your selection of an option button enters its value in a database field. Its field type 
determines what values you can use in the box. In most cases, the field uses text, but this is not a 
requirement.

7) Setting the values for the members of the Options fields list:

a) If you want to use the default values, go to 8.

b) For each member of the listed

i) Select it.

ii) Change the number in the box to the value you want.

8) Click Next.
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The next question is whether you want to enter these values into a database field, or save it as 
part of the form. When a form is part of a database, the selected value is most often saved in a 
database field. Group boxes in a Writer form may want to save the selection as part of the form.

If you are going to save the value in a database field, you select its name in the dropdown list.

9) Selection of a database field into which the value is entered:

• If your selection is Yes, also select the name of the field from the dropdown list.

• Or, select No.

10) Click Next.

This is why you do not need a label group box when using the wizard to create it: it gives the box a 
caption (label). 

11) Enter the name for the Option group (Group Box).

12) Click Finish.

58 Chapter 3 Data Input and Removal



This is a snapshot of what the wizard has created:

This can be done using a label field and 6 options created one at at time. That discussion is next.

Click this link to return to Index of tools used to create labels and fields.

Option button

The option button can be used by itself, or multiple option boxes can be used in a group as in the 
graphic above. The former has two possibilities: either it is selected or it is not. The latter provides 
a multiple choice of mutually exclusive options.

A single option button does not need a label because it has a label property. With a group of 
option buttons, this is used to label (caption) each option button. So, the group needs a label to 
identify the group.

To create a single option button:

1) Have the Form Navigator open and the main form or subform selected in which you are 
working.

2) Click the Option Button tool in the Control toolbar. 

3) Draw the Option button where you want it. Make sure it is wide enough for its label.

The specific properties that apply to options buttons are in the General and Data tabs. The former 
only has 2: Label, and Default status. The latter has 4: Data name, Input required, Reference 
value (on), and Reference value (off).

Usually, in the General tab you enter the name of the field to which option button is linked in the 
Label property. Otherwise, use whatever name you need. Make sure you also set the default 
status property.

In the Data tab, select this field from the dropdown list. And select whether an input is required or 
not. Finally, the reference values determines what is entered into the field. What you enter in the 
Reference value (on) is entered when the option button is selected. What you enter in the 
Reference value (off) is entered when the option button is deselected.

For example, the database associated with the Base Guide has a field for reconciling financial 
transactions to bank statements. Setting Reference value (on) to Yes and Reference value (off) to 
No, we accomplish our purpose. The form shows whether a transaction has been reconciled or 
not, and the Reconcile field has a Yes or a No as to whether a specific row has been reconciled or 
not. (Each row contains one transaction.)

4) Open the Properties dialog if it is not open. (Use the Control tool to do this.

5) Click the option to select it.

6) Click the General tab.

• In the Label property, enter the name you want to follow the option button.

• Default status property: Select from the dropdown list whether the button is Selected 
or Not Selected.

7) Click the Data tab.

Create the database 59



a) If you are going to use the option button to enter data in a database field, select it 
from the Data field property.

b) Select whether an input is required or not.

c) Reference value (on): What you enter here will also be entered into the field when 
this button is selected.

d) Reference value (off): What you enter here will also be entered into the field when 
this button is not selected.

Creating a group of option buttons involves many of the same steps with a small addition: creating 
a label for the group. There is one exception though. With a group, you only enter a value for  
Reference value (on) for each option button. You will have no need for Reference value (off).

When creating the label field, you will be only drawing the outline of it using the Label Field tool. 
The properties or the label and the individual options buttons will be defined after the outline of 
each is drawn.

Tip

When you use a tool to draw the outline of a control, the cursor remains a cross-
hair.  This means you can continue to draw additional controls with the same field 
type as the previous ones. Specifically, you can click the Option Button tool one time 
and draw several option buttons one after the other.

1) Have the Form Navigator open and the main form or subform selected in which you are 
working.

2) Click the Label Field tool, and draw the approximate sized outline for the label.

3) Click the Option Button tool in the Control toolbar. 

4) Draw the Option button where you want it. Make sure it is wide enough for its label.

5) Draw the rest of the option buttons you need for the group of buttons. (Where you place 
them with respect to the previous buttons depends upon how you want to them placed 
together.)

The properties for the buttons are assigned individually. The Label property will contain the caption 
(label) for the individual button and the default status is selected. Finally, selections are made for 
the top three properties in the Data tab. With the Properties dialog is open, you can select a option 
button and assign its properties. Then select another button, and the Properties dialog changes to 
the properties from the previous selection to the present.

Tip

Any time you have several options buttons you are assigning properties to, you 
need to have a plan as to how you will select all of them, one at a time. Selecting 
them from top to bottom works in a column or from left to right or right to left works 
in a row. It is your choice. Once you have your plan, you can define the properties of  
all of them selecting them one at at time.

1) Have the Form Navigator open and the main form or subform selected in which you are 
working.

2) Have the Properties dialog open. (Use the Control tool if necessary to do this.)

3) Create the Label for the group.

a) Click the Label Field tool and draw the outline of the label field where you want it. 
(See Label Field if you need help.)

b) In the Label property, enter the name for the group of option buttons. Make any 
additional modifications to the properties in the General tab you want. 

4) Select the option buttons.

a) Click the Option Button tool. 
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b) Draw the outline of the option button field. Draw it below the label field and wide 
enough to contain its caption.

c) Repeat b) drawing each below the previous one until you have drawn all of the option 
buttons needed for the Group Box.

5) Select the properties for each option button.

a) Click the first option button according to your plan.

i) General tab: 

• In the Label property, enter the caption for the button.

• Default status property: Select from the dropdown list whether the button is 
Selected or Not Selected. (At most only one of the option buttons can be 
selected.)

ii) Data tab:

• Data field: Select the field into which the option button will enter data.

• Input required: Select Yes, if an input is required.

• Reference value (on): What you enter here will also be entered into the 
field when this button is selected.

b) Repeat the steps in a) until you have done them for each option button.

The below figure shows the partially created group box consisting of one label, and 6 optional 
buttons. To be done yet: arrange the parts so they are aligned horizontally, standardized the 
distance between them, group them into one control, and draw a box around them all using the 
Drawing toolbar. All of this will be done when we complete the layout of the form.

Click this link to return to Index of tools used to create labels and fields.

Push Button

This is used for running macros which are not discussed until chapter 8 of the Base Guide. The 
push button is created the same way as the others are: click the tool and draw the outline. Then 
select the properties you want for it.

The Label property is shown centered in the button, and a graphic can be placed inside it. You will 
need to modify the font property to make sure the label can be read over the graphic.

Form layout
This involves three objects: any text, separate areas for the main form or subforms, the controls, 
and the background. This is the general pattern I suggest you follow. However, as you progress, 
you may see the need to make some adjustments in what you have already done. This is normal. 
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You may find that you have to make adjustments several times before you are satisfied. After 
everything else is done, a background can be added from the Gallery or a graphic file. (I 
periodically use a digital photo as a background for a form.)

Added text to a form
Text can be used for a variety of purposes. You can give the entire form a title. You can also give 
the main form and any subforms titles as well. You may want to write an explanation for a part of 
the form. If you have any Pattern fields, you should use text to demonstrate the format used in 
them.

Each form is a text document created by Writer. So, it depends upon styles to determine its 
properties. 

Tip

The Writer Guide contains detailed instructions on how to apply styles. While we do 
not have the space to describe all of these, you can use the guide to learn how to 
apply the styles we do not discuss. Then experiment with an form used as an 
example.

When you create a form, it contains one empty paragraph at the top of it. You create additional 
paragraphs by repeatedly using the Enter key. This permits you to vertically place a title where you 
want it. With the use of the Space key, you can horizontally place title as well.

With multiple paragraphs in the form, you can anchor controls  to one of them instead of anchoring 
all to the top paragraph. Then the controls of the main form (or a subform) can all be linked to the 
same paragraph. The title can be placed in it as well. Then you can move  the title and all of the 
controls associated with it at one time by moving the paragraph.

Styles and Formatting window
Whether you are creating a title or placing text in the form, you should use this to define the 
properties of the styles you use for either. It has lists of styles for each one of these categories: 
paragraph, character, frame, page, or list.

Note

It also contains the format paintbrush with which you can apply a style by selecting 
an area with the cursor. And for the person who would like to use some styles from 
another document, it has New Style from Selection. Both are explained in the Writer 
Guide.

To open this, use the F11 key. This opens a floating window. You can dock this by holding down 
the Control key while double clicking between these two icons:  The window docks on 

the left side of the LibreOffice window. When you don't need it, use the F11 key again to close it. 
And if you no longer want it docked, you can put the cursor between these two icons and drag the 
window to wherever you need it. This includes dragging it to the right side of the LibreOffice 
window to dock it there.

Some people work well with it being a floating window, and others prefer to dock it.  The choice is 
yours. I use it so often that I have mine docked.

At its bottom you see a dropdown list. The default value is Automatic. Its lists contain the styles 
that most people will probably use. There are 11 other choices in this list, and each has its own set 
of styles.
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This window is opened with Paragraph Styles selected (the left icon is highlighted). For any titles 
we need in the form, the Heading styles  numbered 1-10 will work well. The Heading style, itself is 
only used to define the properties that all headings have. The numbered Heading styles are linked 
to it which gives each of them these properties. For normal text, Text body is a good choice.

Each style can be modified by right clicking it and selecting Modify from the context menu. This 
opens a dialog containing several tabs of style settings. The title on the dialog's banner tells you 
whether it is for a paragraph, character, frame, page or list style and its name.

The dialog has 12 tabs. The ones we will discuss are Indents & Spacing, Alignment, Font, and 
Font Effects.  You may find a use for some of the others as well. Background and Borders can be 
used when organizing the parts of the form (main form and any subforms).

 

Entries in the Indents & Spacing tab determines 

Titles
Included in these are one for the form, one for the main form (if there is a subform), for the 
subforms, and for an area you want identified. For example, a grocery list form might contain titles 
for the vegetables, meats, dairy products, vitamins, frozen foods, … Each of these may have 
different font sizes, colors, alignments, and different spacing. Some of them may have the same 
properties. In our example, you might want the titles for types of food to use common properties. 
Or, you might want each to differ from the others to call attention to the differences.

The form contains one empty paragraph that begins at the upper left corner. 
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1) Text in the form

a) Titles

b) explanations

2) Dividing the form into parts (main form, subforms) 

a) including separating lines

b) box surrounding a part

3) Controls

a) Anchoring controls within their part

b) Changing the size of a control

c) Changing the location of a control

d) Changing the location of a group of controls for centering purposes.

e) Modifying control background and border

f) modifying relative positions of a control's label and field

4) Background

a) Gallery

b) Graphic file

Step 6: Test the form with sample data

Background of form (colors, picture, items from gallery)

Create a database with Base and then Connect to it using 
Base

10/18/12

64 Chapter 3 Data Input and Removal


	Copyright
	Introduction
	Create the database
	Create the database file
	Create the tables
	Using the Table Wizard
	Create a table in design view
	Name your fields
	Setting the Field Type for each field

	Adding a Description
	Setting Field Properties in the Table
	Setting a Primary Key
	Using the Table Design dialog

	Saving the table

	Create the form
	Form Wizard
	Design View
	Needed toolbars
	Design View steps


	Form layout
	Added text to a form
	Styles and Formatting window
	Titles

	Background of form (colors, picture, items from gallery)


	Create a database with Base and then Connect to it using Base

	Numeric Field 1: 


